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1 Getting started

Printing this guide
Change the paper size to print this document on any printer.

1. Open the PDF file in Adobe Acrobat.

2. From the File menu, select Print.
The Print dialog box appears.

3. Select the desired paper size, for example, A4 or letter.

4. In the Page Scaling list, select Fit To Printable Area or
Shrink To Printable Area.

Note: The names in the Page Scaling list vary according to the version
of the Adobe Acrobat software.

5. Click OK.
This document is printed to the selected paper size on your
printer.



What's new?
The IC-309m print controller supports these new features and
enhancements:

● Auto preflight—A preflight is automatically generated for each
job that is imported to the IC-309m print controller

● Smart gallop—The Gallop option is selected by default, and
enables processing while printing

● Fast Pack—adds parallel processing

○ Adds one RIP mode

○ Job can be processed with multiple RIPs

○ Multiple short jobs can be processed simultaneously

Note: This pack is optional. A dongle is required.

● Finishing sets for cut-and-stack imposition method

● Incoming queue—Provides improved job management and
analysis

● Job slug in Job Preview tool

● PDF/VT support

● Optimized processing of jobs with page ranges

● Extended page exceptions support—For example, mix-plex

● Dynamic page exceptions editing

● Thumbnail preview during imposition programming

● Edit location of crop marks

● Perfect bound imposition method—Nested saddle-stitch

● Step-and-continue imposition method—Reading order

● Perfect bound imposition method—Sets per sheet

● Stacking mode for VDP—Saddle-stitch and Perfect Bound
imposition methods

● Folded signature imposition method

● Enhanced Trans Pack

Note: This pack is optional. A dongle is required.

○ Integrated bidirectional IPDS printing support

○ Dual mode—Switch between IPDS and File Submission
modes
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○ AFP file format support (FSM mode)

○ CMOCA—Supports full color management for AFP/IPDS

System overview
The IC-309m print controller, powered by Creo Server
Technology, for the Konica Minolta monochrome bizhub presses is
an on-demand prepress system that runs on a Microsoft Windows
Embedded Standard 7 (WES) SP1 operating system and uses
advanced prepress technologies to drive the Konica Minolta
monochrome bizhub presses.

The IC-309m print controller enables you to print from computers
running the Microsoft Windows operating system, Apple Mac OS X
operating system software, and The Open Group UNIX client
workstations. Using raster image processor (RIP) technology, the
IC-309m print controller performs pre-RIP preflight on each file
that is imported to the IC-309m print controller and converts image
files in page-description language (PDL) formats (for example,
Adobe PostScript, PDF, and variable data printing formats) to a
suitable ready-to-print (RTP) format for direct high-quality digital
printing. The IC-309m print controller also streamlines the printing
process by allowing you to print with preset workflows.

The IC-309m print controller submits jobs to the printer in PDF
format using JDF/JMF protocol. IC-309m preset workflows and full
bidirectional JDF/JMF communication between the IC-309m print
controller and the printer enables maximum efficiency and
streamlining of the printing process.

The IC-309m print controller enables the efficient printing of flyers,
brochures, pamphlets, catalogs, short-run trials, and print-on-
demand publications. When installed as a fast network printer with
the IC-309m print controller, the printer prints at the full-rated
speed of 125 (Konica Minolta monochrome bizhub presses) black
and white A4 (210 mm x 297 mm) or Letter (8.5 inches x 11
inches) simplex pages per minute, on different media types and
weights.

The IC-309m print controller combines RIP functionalities,
automation, control tools, and special hardware development
capabilities with Windows-based architecture.

If you have the Trans Pack, the IC-309m print controller supports
transactional printing using the IPDS workflow including
bidirectional communication with an IPDS host. You can configure
the IC-309m print controller to either:
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● File submission mode, which enables you to print from any
computer, import and process all the supported file formats,
apply and edit the job parameters, and manage your files.

● IPDS mode, which enables you to process and print IPDS jobs
from the IPDS host computer. In IPDS mode you can apply and
edit the IPDS printer parameters.

Hardware and software components
The IC-309m print controller includes:

● Creo hardware, including the dedicated interface (fusion) board
● Off-the-shelf hardware
● DVD-RW drive with DVD burning software
● The following software:

○ IC-309m print controller software
○ Windows Embedded Standard 7 (WES) SP1 x64 operating

system
○ Adobe Acrobat 10 and PDF 1.7
○ Enfocus PitStop Edit 11
○ Microsoft Internet Explorer 8

Supported formats
The IC-309m print controller supports the following file formats:

● PostScript (composite files) (levels 1, 2, and 3)
● Adobe PDF (versions 1.2 through 1.7)
● EPS
● Creo VPS (Variable Print Specification)
● PPML (Personalized Print Markup Language)
● PPML.zip
● PPML/VDX
● TIFF/IT
● Pre-separated postscript files
● PDF/VT - PDF/VT1 and PDF/VT2
● JDF/JMF
● XPS
● AFP—part of the Trans Pack
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● JPEG

● TIFF—supports TIFF 6.0 files saved with sliced internal data
structure, regardless of the BPP (Bits per Pixel) and
compression method. Includes support for multi-page TIFF

Action Pack
This pack is optional. To activate the features in the software you
need to install the dongle that is supplied with the pack.

This pack includes the following features:

● Enfocus PitStop Edit

● Global Reusable Elements Management tool

● Imposition Template Builder

● Exception Mapping and Rules Set—Dynamic Exceptions (SPD)

● Folded signatures

● Mark sets

Fast Pack
This pack is optional. To activate these features in the IC-309m
print controller software, you need to install the dongle included in
the pack.

This pack includes the following features:

● Additional RIP process mode

● Keep job in original order

● Parallel RIP at job level

● Parallel RIP at page level

● Smart/Full Gallop

Preps Pack
This pack is optional. To activate these features in the IC-309m
print controller software, you need to install the dongle included in
the pack.

This pack enables you to build custom signatures, and define
where marks or groups of marks are placed on a sheet. In
addition, there is an interactive job ganging option.
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Installing the Preps Pack
To activate the features in the Preps Pack, install the dongle that
is supplied with the pack.

1. Log on to your computer as an Administrator.

2. Obtain the software files. The
Preps_7-0-0_Win_Installer.exe file is available on the
DVD.

3. Insert the DVD, and double-click the .exe file.

4. Click Install and follow the on-screen instructions until the
installation is complete.

5. When the iKey driver window appears, type your license key
to complete the installation.

Trans Pack
This pack is optional. To activate these features in the IC-309m
print controller software, you need to connect the dongle included
in the pack.

The Trans Pack enables transactional printing using the Intelligent
Printer Data Stream (IPDS) workflow including bidirectional
communication with an IPDS host.

You can configure the IC-309m print controller to work in either:

● File submission mode—enables you to print from any
computer, import and process all the supported file formats,
apply and edit the job parameters, and manage your files. This
includes Advanced Function Printing (AFP) file format support,
which enables you to import, process, and print AFP files
directly in file submission mode.

● IPDS mode—enables you to process and print IPDS jobs from
the IPDS host over bidirectional and secured communications.
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Turning on the IC-309m print controller
1. Turn on the monitor.

2. Turn on the printer.

3. Open the door on the front of the IC-309m print controller, and
push the power control button.
The power indicator on the front panel lights up, and the
Windows operating system logon screen appears.

The IC-309m print controller splash screen appears, followed by
the workspace.

Note: If the workspace does not automatically appear, open the application
from the Windows Start menu. By default, the Windows screen saver is off.

See also:
Preferences window on page 139

Turning off the IC-309m print controller
1. From the File menu in the workspace, select Exit.

Note: Alternatively, if you want to exit the Workspace only (and not shut
down the Creo server), select Exit Workspace. This is useful when you
make a change to the settings that require you to close and open the
Workspace, for example, when customizing the font size in the user
interface. To restart the Workspace, right-click on the Creo server icon
in the system tray and click Start.

A confirmation message appears.

2. Click Yes.
The IC-309m print controller software closes. This may take a
few minutes.

Note: If you move the cursor over the server icon on the taskbar, the
following tooltip appears: Creo Server is Stopping. Please Wait.

3. Verify that the IC-309m print controller icon does not appear
on the taskbar.

4. From the Windows Start menu, select Shut Down, and click
OK.

Overview of the workspace
The workspace automatically appears when you start the
software .
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Note: When the IPDS workflow mode is selected, certain features and
options are not available in the workspace.

The workspace contains different areas that enable you to monitor
your job during the process and print stages. In addition, the
workspace includes tools and options that enable you to fully
customize and manage your server and jobs.

Workspace area Description

Toolbar

Consists of shortcut buttons to commonly used tools and windows such

as Import window , Resource Center  , Spot Color Editor

, Gradation , Job Preview , Archive , Imposition

Template Builder , and Alerts .

In addition, you can customize the toolbar area by adding, removing,
and rearranging toolbar buttons from the repository in the Toolbar
customization window.

Note: The icons that appear vary according to the optional packs in
use.
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Workspace area Description

Printer Status pane The Printer Status pane displays information about the current printer
status—for example, Printing, Ready, Warming up.

The printer icon changes according to the configuration of the printer
and the finishing devices connected.

Resource details Click Input Trays, Finishers, Toners, or Server to display information
about the size and type of paper in each tray, the connected finishing
devices, the available toner, status of consumables, and disk space
and network details.

The Server area provides network, workflow mode (either IPDS or File
Submission Mode) and disk space details. In IPDS workflow mode,
the IPDS Connection Status appears, that is, Disconnected or
Connected.

Note: You can change the workflow mode in the Preferences window.

Under Server, you can also view the date when the printer was last
calibrated. Progress bars display information about incoming and
outgoing jobs. Details about the status of the system and image disks,
for example, the amount of available disk space on each disk, are
shown. In addition, the date of the last calibration (if applicable) and the
data cables connected is shown.

In IPDS mode, you can click Abort Job to abort all the IPDS jobs in the
queues. The jobs and RTP files are deleted. If you need to disconnect
from the IPDS host, click Disconnect.

If there is a problem with one of the printer components or with the
server, a red indicator appears in the printer icon and next to the
relevant component—for example, if a tray is empty.
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Workspace area Description

Incoming Queue, Process
Queue and Print Queue

The Incoming Queue area lists all incoming jobs. This queue is
available by selecting the Full View option from the View menu.

The Process Queue area lists the files to be processed. After a file has
been processed successfully, it moves either to the Print Queue area
or to the Storage area.

 Indicates that the queue is ready for processing or printing.

 Indicates that the queue is suspended. You need to release the
queue in order to process and print the jobs in this queue.

Note: When a queue is suspended you can open and edit the job
parameters of a job, unless the job is active or printing in the print
queue.

A preflight check is automatically executed on files running in the
incoming queue. This checks for the existence of external files/
elements (high resolution files), SPD/dynamic exceptions, page size,
and AFP resources. If the auto preflight passes and you then want to
check for other resources (for example, fonts or spot colors), you
should run a full preflight check as described in Verifying the content of
the job. If the job fails, the preflight check it is moved to the Storage
area and marked with a red X (failed) in the Preflight column.

Note: If a job fails the preflight check, you can view the preflight report
by right-clicking on the job and selecting Preflight Report. For more
information, see Viewing and printing a preflight report.
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Workspace area Description

Storage area The Storage area contains jobs that were:

● Successfully printed

● Held, aborted, or failed during processing or printing

● Sent directly from the client workstation, or imported into the
Storage area

There are three different views available in the Storage area: List,
Preview, and Gallery.

Icons in the Process column indicate the following processing
information:

● : The file requires processing

● : The file was partially processed

● —The file was fully processed

You can modify the columns and information that is displayed in the
Storage area. Right-click on a column in the Storage area and select
the column that you want to add or remove.

in addition, the Storage area displays a thumbnail of the selected job.

Note: Selecting Copies enables you to change the number of copies
for that job and submit it for printing without opening and editing the job
parameters.

Overview of the workspace 11



Customizing the workspace toolbar
Add shortcut buttons to the workspace toolbar, remove buttons
from the toolbar, and rearrange buttons on the toolbar.

1. From the Tools menu, select Toolbar customization.

2. Perform any of the following actions:

○ To add a button to the toolbar, select the button from the
Available toolbar buttons area and click Add.

○ To remove a button from the toolbar, select the button from
the Current toolbar buttons area and click Remove.

○ To move a button to a different position on the toolbar,
select the button in the Current toolbar buttons area, and
then click any of the following sorting icons:

● : Moves the toolbar button to the first position (on the
left end of the toolbar)

● : Moves the toolbar button one position to the left

● : Moves the toolbar button one position to the right

● : Moves the toolbar button to the last position (on the
right end of the toolbar)

3. Click Save.
The workspace toolbar displays your latest changes.
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Customizing the user interface font size
Select a font size for the user interface that accommodates the
resolution of your monitor.

1. From the File menu, select Preferences.

2. Click UI Customization.

3. In the Font size area, select a font size.
The Preview area displays a phrase showing the font sample.

4. Click Apply.

5. When a message appears telling you to exit and restart the
software, click OK.

6. Click Save.

Next: For the new settings to take effect, exit and then restart the
workspace.

Customizing the user interface font size 13
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2 Setting up your
computer for printing

Setting up your computer—overview

Printing Methods
Methods for printing with the IC-309m print controller:

● Submit the job to one of the IC-309m print controller virtual
printers. The job is spooled, analyzed, and then processed or
printed (according to the selected job flow of the virtual printer).
If you use this method, you can print from any software (for
example, Adobe Acrobat) and use any file format from any
Windows and Mac computer.

● Drag the job to a hot folder. The job is spooled, analyzed, and
then processed or printed (according to the selected job flow of
the corresponding virtual printer). If you use the hot folder
method, you can print most PDL files (for example, PostScript,
PDF, EPS, Variable Print Specification, and PPML).

● Drag Microsoft Office files to a special hot folder and then
submit the files for printing.

Network printers
To print your file using a IC-309m print controller virtual printer, you
first need to install the virtual printer as a network printer on your
computer.

After you install a network printer on your computer, you can
submit files for printing. By default, the network printers are
installed with the Print Driver software. You can change the default
settings of the network printer to use the PPD parameters instead
of the Print Driver software.

The IC-309m print controller supports printing from the following
operating systems:

● Microsoft Windows Server 2008, Microsoft Windows Server
2003, Microsoft Windows 7, Microsoft Windows Vista, and 
Microsoft Windows XP

The IC-309m print controller provides default network printers,
referred to here as virtual printers.



A virtual printer contains preset workflows that are automatically
applied to all print jobs processed with that virtual printer. The
default virtual printers are published on the network with specific
parameters set for processing and printing.

The default virtual printers are:

● Print—Files sent to this printer are automatically processed
and immediately sent to the printer for printing.

● Process—Files sent to this printer are automatically processed
and stored in ready-to-print (RTP) format in the Storage area.
Later, you can submit an RTP job for printing, or change the
parameters of the job and resubmit it for processing or printing.

● Store—Files sent to this printer are spooled to the Storage
area and wait until you submit them for processing and printing.
The files remain in PDL format (such as PS, PDF, VPS, and
PPML).

● Print&Delete—Files sent to this printer are processed and
printed. After the job is printed successfully, the RTP is deleted.

Print Driver software
Use the print driver software to set job parameters when you are
submitting a job to the IC-309m print controller from any
application in your computer. The Print Driver software provides a
graphical user interface that is similar to the IC-309m print
controller job parameters window. The software is automatically
installed on a Windows computer when you set up a network
printer.

Note: On a Mac computer, you must install the Print Driver software
manually.

In the Print Driver window, you can perform the following actions:

● Define or change job parameters regardless of whether your
computer is connected to the server.

● Lock a job for secure printing.

● Save a set of parameters. Sets are useful when you want to
print different jobs with the same parameters, or if you want to
reprint a job.

● Retrieve a saved set of parameters.

● Check the status of the printer.

● Define PostScript parameters for the job.

● Preview imposition layout.
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Note: Custom imposition templates, including the pre-defined Folded
Signature imposition templates, cannot be previewed from the Printer Driver
software.

Setting up printing on a Windows computer

Adding a network printer to Windows Server 2008/2003/XP
To print from a Windows computer, you first need to add an
IC-309m print controller virtual printer to your client workstation.

Tip: Following are some shortcut tips for setting up a printer. The full
procedure is detailed below.

● Locate the IC-309m print controller in My Network Places, and then
double-click on the network printer you want to install. The network printer
is automatically installed on your computer and appears in the list of
printers.

● If you know the name of your IC-309m print controller, click Start > Run,
and then type \\server name. The IC-309m print controller opens
showing a list of all the network printers. Double-click on the network
printer you want to install.

1. From the Start menu, select Settings > Printers and Faxes.
The Printers and Faxes window appears.

2. In the Printer Tasks area, select Add a printer.
Note: Your computer might have slightly different wording from what
appears in this task.

The Add Printer Wizard appears.

3. Select Next.
4. Select A network printer, or a printer attached to another

computer, and click Next.
5. Select Browse for a printer, and click Next.
6. Find the IC-309m print controller, and double-click it to display

the list of network printers.

7. Select the desired printer, and click Next.
8. When a message appears, click Yes.

9. Select Yes if you want to set this printer as the default printer
on your computer, otherwise, select No, and click Next.

10. Click Finish to close the wizard.

The IC-309m print controller network printer is added to your
printer list. In addition, the Print Driver software and PPD file are
automatically copied.
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Adding a network printer to Windows 7/Vista
To print from a Windows computer, you first need to add an
IC-309m print controller virtual printer to your client workstation.

Tip: Following are some shortcut tips for setting up a printer. The full
procedure is detailed below.

● Locate the IC-309m print controller in My Network Places, and then
double-click on the network printer you want to install. The network printer
is automatically installed on your computer and appears in the list of
printers.

● If you know the name of your IC-309m print controller, click Start > Run,
and then type \\server name. The IC-309m print controller opens
showing a list of all the network printers. Double-click on the network
printer you want to install.

1. From the Start menu, select Devices and Printers.

2. Select Add a printer.

3. In the Add Printer wizard, select Add a network, wireless or
Bluetooth printer.

4. Select The printer that I want isn't listed.

5. In the Select a shared printer by name box, type the
IC-309m print controller name, and click Next.

6. Click Next.

7. Select whether you want this to be the default printer, and
then click Finish to complete the setup.

The IC-309m print controller network printer is added to your
printer list. When you add a network printer, the Print Driver
software and PPD file are installed on your computer.

Loading the Print Driver software for the first time
Requirements:

A network printer must be defined on your Windows-based
computer.

18 Chapter 2—Setting up your computer for printing



Load the Print Driver software after installing a network printer so
that the IC-309m print controller will be ready for printing.

1. Open a file with its corresponding application—for example,
open a PDF file in Adobe Acrobat.

2. From the File menu, select Print.
The Print dialog box appears.

3. Select one of the network printers—for example, Print and
click Properties.
A message tells you that the software is loading.

Note: This process might take a few minutes.

After the software loads successfully, click Finish. The job
parameters window appears.

4. Close the job parameters window and the Print Dialog box to
complete the installation of the Print Driver.

The network printer is set up for printing using the Print Driver
software.

Shortcut for adding a printer
1. From the Start menu, select Run.

2. In the Open box, type \\, followed by the host name or IP
address of the Creo server, and click OK.
The server window opens.

3. Double-click the icon for the desired network printer.

The IC-309m print controller network printer is added to your
printer list.

Shortcut for adding a printer 19



Deactivating the Print Driver software
The Print Driver software is active by default. Deactivate the Print
Driver software if you want to access the PPD file parameters.

1. Perform one of the following actions:

○ For Windows Server 2008/2003/XP, from the Windows
Start menu, select Settings > Printers and Faxes

○ For Windows 7/Vista, from the Windows Start menu, select
Devices and Printers

2. Right-click the network printer icon for which you want to
deactivate the Print Driver, and do one of the following:

○ For Windows 2008/2003/XP, select Properties
○ For Windows 7/Vista, select Printer properties

3. Click the Print Driver tab.

4. From the Enable enhanced user interface list, select off.
5. Click Apply.

6. Click OK.

Removing the Print Driver software
Perform this procedure if you need to upgrade to a later version of
the Print Driver software.

Requirements:

All applications must be closed before removing the Print Driver
software.

1. From the Windows Start menu, select Run.

2. In the Open box, type \\, followed by the host name or IP
address of the server, and click OK.
The server window opens.

3. Navigate to \Utilities\PC Utilities\Driver Extension.

4. Perform one of the following:

○ If you are using Windows XP, double-click
DEX_Uninstaller.exe

○ If you are using Windows Vista or Windows 7, right-click
DEX_Uninstaller.exe, and select Run as Administrator.

The Print Driver software is removed.

20 Chapter 2—Setting up your computer for printing



Downloading fonts
Use the HF_FontDownLoader hot folder, located in D:
\HotFolders, to install new or missing fonts to the IC-309m print
controller fonts directory.

The HF_FontDownLoader hot folder can be used with the following
operating systems:

● Windows Server 2008
● Windows Server 2003
● Windows 7
● Windows Vista
● Windows XP
● Mac OS X 10.6 (64 bit) and later

You can drag the required fonts from the computer to the
HF_FontDownLoader hot folder. In the Resource Center, you can
set a default font and delete fonts.

Note: You can only copy fonts if the font license permits.

Setting up a TCP/IP Printer in Windows 7
Set up a TCP/IP printer on a Windows 7 computer.

1. Open the Devices and Printers window.

2. In the Devices and Printers window, select Add a printer.
The Add Printer Wizard appears.

3. Select Add a local printer.
4. Select Create a new port, and from the Type of port list,

select Standard TCP/IP Port.
5. Click Next.

If you have Print Services for UNIX installed on your
computer, you can also select LPR Port from the Type of
port list.

6. In the Hostname or IP Address box, type the exact name of
the IC-309m print controller (the name is case-sensitive). You
can leave the Port Name as is.

7. Clear the Query the printer and automatically select the
driver to use check box.

8. Click Next.
9. In the Device Type area, select Custom, and then click

Settings.
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10. For Protocol, select LPR.

11. Under LPR Settings, set the values as follows:

a. For Queue Name, type the exact name of the network
printer to which you want to send jobs for printing—for
example, CCS_Print.

b. Select the LPR Byte Counting Enabled check box.

12. Click OK, and then click Next.

13. Click Have Disk.

14. Click Browse, and locate the OEMSETUP.INF file in the \
\<server_name>\Utilities\PC Utilities\Printer
Driver\Printer driver application\US-Letter or
Europe-A4 folder.

15. Select the file, and click OK.

16. Click Next.

17. In the Printer name box, delete the default printer name and
type the printer name exactly as it appears in the Resource
Center—for example, %Server Name%_Print.

18. Click Next.

19. Make sure that Do not share this printer is selected, and
click Next.

20. Clear the Set as default printer check box.

21. Click Finish.

22. In the Devices and Printers dialog box, right-click the newly
created printer, and select Printer Properties.

23. Click the Print Driver tab.

24. Click the Server Hostname, and type the host name of the
Creo server.

25. Click Apply, and then click OK.

26. When you send a job to print via the Print Driver software,
note that the Print Driver is Online.

You have successfully installed a network printer for the IC-309m
print controller and are ready to start printing.
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Setting up printing in Mac OS X

Installing the Print Driver software in Mac OS X 10.6 (64 bit)
and later

During the installation of the Print Driver software, the PPD file is
automatically copied to your computer.

Notes: Starting from Mac OS X Lion (10.7) computers, some features in
different DTP applications require the Oracle Java Runtime Environment
(JRE). Starting from Lion, OS X does not provide a Java Runtime by default.
Current IC-309m print controller installers and applications were built before
these changes to Mac OS X and assume that Java is installed. If Java
runtime isn't installed, the following issues can occur in DTP applications:

● Features are missing or behave improperly

● The software doesn't start

● Prompts to install Java Runtime occur

● Applications hang or quit

If you are working with Mac OS X Lion and Creo server remote tools, make
sure that Java Runtime is installed on your computer. Follow the Java
installation procedure on the Apple site, http://support.apple.com/kb/DL1421.
This will ensure that the Creo server tools work correctly.

1. From the Go menu, select Connect to Server.

2. In the Server Address box, type your server address, and
click Connect.

3. In the Connect as area, select Guest.

4. Click Connect.

5. Select Utilities and click OK.

6. Select the Mac Utilities folder.

7. Double-click the
IC-309m_ColorServerPrintDriverInstaller.dmg file.

8. Double-click the
IC-309_ColorServerPrintDriverInstaller icon.
The Welcome screen appears.

9. Click Continue.

10. In the message window, click Continue.

11. In the Software License Agreement window, click Continue.

12. Click Agree to agree to the terms and continue with the
installation procedure.
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13. In the Select Destination area, select the destination volume
in which you want to install the Print Driver software, and click
Continue.

14. Click Install.
15. Type your login name (if necessary) and password, and click

OK.

16. Click Close.

The Print Driver software and PPD are installed.

Note: If you deactivate the Print Driver software, you can still use the PPD
because it has already been installed.

Defining a printer with the Print Driver software in Mac OS X
10.6 (64 bit) and later

Requirements: The following information must be available:

● IP address or computer name of your IC-309m print controller

● Name of the network printer that you want to use with the Print
Driver software

1. On your Mac computer, using the Apple icon, open the
System Preferences window and double-click Print & Scan.

2. In the Print & Scan window, click +.

Note: You can also define your printer using the Default option.

3. In the Printer Browser window, click the IP Printer tab, and
enter the following information:

○ In the Address box, type the address of your server.

○ In the Queue box, type the name of the network printer that
you want to use with the Print Driver software—for
example, CreoCS_Process.

○ In the Name box, type a name for the printer.

○ In the Print Using list, select Other.

4. Navigate to Library / Printers / PPDs / Contents /
Resources / en.lproj, select either Europe-A4 or US-
Letter, and then select the IC-309m.PPD file.

5. Click Open.

6. Click Add.
The network printer is defined with the PPD file.
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7. In the Print & Scan window, double-click the network printer.

8. Click Printer Setup.

9. Click Utility.

10. Click Open Printer Utility.

11. In the Enable Enhanced User Interface list, make sure that
On is selected.

12. In the Server Hostname box, type the IP address of the
server or the server name.

13. Click Apply, and then click OK.

Removing the Print Driver software in Mac OS X
Perform this procedure if you need to upgrade to a later software
version of the Print Driver software.

Requirements:

All applications must be closed.

1. From the Go menu, select Connect to Server.

2. In the Server Address box, type your Creo server host name
or address, and click Connect.

3. In the Connect as area, select Guest.

4. Click Connect.

5. Select Utilities, and then click OK.

6. Select the Mac Utilities folder.

7. Double-click the CCSUninstall.dmg file.

8. Double-click the CCSUninstall.app file.

9. Close all the running applications on your Mac computer, and
then click OK.

10. Select the suitable Creo printer driver, and then click OK.

11. If necessary, type your name and password, and then click
OK.

12. Click OK.

The Print Driver software is removed. You can now upgrade the
Print Driver software.

Note: After you upgrade the software, you need to reinstall the network
printers.
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3 Printing a file in
Windows and Mac OS

Printing a file to the IC-309m print controller
Requirements:

A network printer must be defined on your Windows and Mac
computer.

1. Open a file with its corresponding application—for example,
open a PDF file in Adobe Acrobat.

2. From the File menu, select Print.

3. In the Name list, select the desired network printer—for
example, <server_name>_Print.

4. (Optional) To modify job parameters:

Option Description

Windows Click Properties.

Mac Select Special Features, and
then click Job Parameters.

a. Modify the parameters.

b. Click OK.

5. In the Print dialog box, click OK.

The file is sent to the IC-309m print controller where it is processed
and printed.

Using a hot folder to print
Use hot folders to automate your workflow and save time by
simultaneously submitting multiple files for printing.

You can use hot folders to process and print files from any
computer. The following procedure can also be followed on a Mac
computer.

1. On your Windows desktop, double-click the My Network
Places icon.
In Mac OS X, from the Go menu, select Connect to Server.



2. Locate the IC-309m print controller, and double-click it.
A list of all the shared folders, hot folders, and printers
appears.

3. Double-click the desired hot folder—for example, HF_Print.

Tip: You can drag the hot folder icon to your desktop to create a
shortcut to the hot folder for future use.

4. Drag the desired files to the hot folder.

All the files are processed and printed automatically, according to
the hot folder workflow.

Password protect jobs
Control the printing of sensitive data by locking and password-
protecting a job on your computer.

Requirements:

● A IC-309m print controller network printer must exist on your
client workstation.

● The printer status on the IC-309m print controller must be in
Ready mode.

Using the Print Driver software, you can apply a password to a job
that was created in any application. Whoever prints or reprints the
job must use the password to unlock it and release it for printing.

1. On your computer, open a file—for example, a PDF file.

2. From the File menu, select Print.

3. In the Print dialog box, in the Name list, select the name of the
network printer that you want to submit your file to.

4. Click the Properties button.
The Print Driver window appears.

5. In the Print Driver window, click the Lock button .
The Secure Printing dialog box appears.

6. In the Password box, type a password consisting of four digits
—for example, 9999.

Note: The password must consist of exactly four numeric characters.

7. Click OK.
The job is password-protected, and nobody can print it without
using the password.
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8. In the Print Driver window, click OK.
The password-protected job is submitted to the network
printer, which sends it to the IC-309m print controller for
processing and printing.

9. In the Print Queue area, right-click the password-protected
job that you want to print, and select Release to print.
The Secure Printing dialog box appears.

10. In the Password box, type the password that was defined for
this job.

11. Click OK.
The job is unlocked and printed. When the printing is finished,
the job is automatically deleted.
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4 Processing and printing
from the Creo server

File processing
The IC-309m print controller features the Adobe PDF Print Engine
(APPE) RIP as a complementary workflow to the Configurable
PostScript Interpreter (CPSI) RIP, enabling you to use the RIP that
is appropriate for each job. The APPE RIP is particularly useful for
files that need transparencies and overprint handling. APPE RIP
information is added to the job history and workspace.

By rendering PDF content natively, at its highest level of
abstraction, and by relying on JDF to capture job ticket and
process control information, the print workflows powered by the
APPE enable designers and print production professionals to keep
PDF content device-independent throughout the workflow.

The main benefit of the APPE RIP is that complex designs and
effects, including transparencies, can be reproduced reliably.
Designers and printers can make late-stage edits in PDF files more
easily and configure PDF jobs for printing on different types of
output devices and presses.

The APPE RIP applies to PDF files only, all other files are
rendered with the CPSI RIP.

One of the advantages of using a PDF workflow is that you can
work with embedded ICC profiles. The IC-309m print controller
includes APPE RIP support for both CMYK and RGB embedded
ICC profiles.

The IC-309m print controller is compatible with PDF/X-1a, PDF/
X-3, PDF/X-4, PDFX4P, and, PDFX5G. PDF/X files are a subset of
PDF files whose standard provides for the exchange of final print-
ready pages. Using PDF/X-compliant files eliminates the most
common errors in file preparation (for example, fonts that are not
embedded, incorrect color spaces, missing images, and
overprinting or trapping problems).

See also:
Services tab in the job parameters window on page 134



Importing and printing a job
You can import a job in any of the following circumstances:

● When a page-description language (PDL) file—for example,
PDF or PostScript—is created on a computer that is not
connected to the IC-309m print controller

● When a PDL file is located on a folder on the network or on
external media, such as a USB flash drive

● When the desired file resides locally on the IC-309m print
controller

1. From the File menu, select Import.

2. In the Import window, in the upper list, select the desired file or
files and click the Add button.

Notes:

● To select several files, click them while holding down the Shift or Ctrl
key; to select all the files, press Ctrl+A. If desired, add the same file
more than once.

● To remove a file, select the desired file in the Import window, in the
lower list, and click the Remove button.

The selected file or files appear in the lower list.

3. From the Virtual printer list, select a printer.

4. Click Import.
All files in the lower list are sent to the IC-309m print controller
to be analyzed, and then processed, printed, or stored as
defined in the selected virtual printer.

Resubmitting a job
Resubmit a printed job after editing the job parameters or to print
more copies of your job.

In the Storage area, right-click the job that you want to
resubmit for printing, and select Submit.
If you select an RTP job, it is submitted to the Print Queue; if
you select any other kind of job, it is submitted to the Process
Queue.
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Note: Some RTP jobs might require reprocessing after you edit certain
parameters.

Resubmitting several jobs via a virtual printer
Apply a modified set of parameters to selected jobs, and then
resubmit the jobs for processing and printing.

Requirements: A virtual printer must already have been created
that contains the modified workflow for the jobs that you want to
resubmit

1. In the Storage area, select the jobs that you want to resubmit
via the virtual printer.

2. Right-click the selected jobs, and select Resubmit to.

3. Select the virtual printer that you created.
The selected jobs are sent for reprocessing and printing.

Note: The original jobs are not deleted.

Printing copies of a job
Reprint more copies of a job directly from the Storage area
without opening the job parameters window.

1. Right-click on a column heading in the Storage area.

2. Select Add > Copies to add copies to the Copies column in
the Storage area.

3. Select the job, and in the Copies field type the number of
copies that you want to print.

4. Press Enter.

5. Drag the job to either the Process Queue area or Print
Queue area.

Job Editor tool
The Job Editor tool enables you to edit and adjust non-VDP jobs
before they are processed.

By right-clicking a job in the Storage area, you can open the Job
Editor tool and view thumbnails of each page in your job and then
perform basic editing tasks such as:
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● Replacing specific pages of your job with pages from another
job

● Merging one or more jobs with another job

Note: The Job Editor tool always creates a new PDF file, combined with all
the operations that have been applied by it, such as: merging jobs and
replacing pages. Edited jobs with other than PDF formats cannot be saved to
their original file type and will be saved as PDF type.

Merging jobs
Create a new job by merging one or more jobs with your job.

Note: You cannot perform this procedure remotely.

1. In the Storage area, right-click one of the jobs that you want
to merge and select Job Editor.
The Job Editor displays thumbnails of the selected job.

2. Click Merge an Entire Job.
The Merge dialog box appears, listing all the non-VDP jobs in
the Storage area.

3. Click the job that you want to merge and perform the following
actions:
To select multiple jobs, use the Ctrl key.

a. In the Insert list, select Before or After.

b. Specify where to insert the designated job, either before or
after the first page, last page, or a specific page.

4. Click Merge.
The jobs are merged and the page numbers are updated
accordingly.

5. Click Save as.

6. Type a new name for the merged job.

7. Click OK.
Your new job is saved.

Replacing specific pages in your job
Replace specific pages in your job with pages from another job.

Requirements: The job that includes the pages that you want to
replace need not have the same page size and orientation as the
job you are editing.
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1. In the Storage area, right-click the job whose pages you want
to replace and select Job Editor.
The Job Editor displays thumbnails of the selected job.

2. Click Replace Specific Pages.
The Replace dialog box appears and displays the list of all
non-VDP jobs in the Storage area.

3. Click the job that includes the replacement pages.

4. In the Replace pages boxes, type the page numbers of the
pages that you want to replace.

5. In the With pages boxes, type the page numbers of the
replacement pages.

6. Click Replace.

7. Click Yes to replace the pages.

8. Click Save as.

9. Type a new name for the job.

10. Click OK.
Your new job is saved.

Proofing a job
Before printing your job, it is important to check the job and make
sure that it will print correctly. Proofing your job can reveal
problems such as missing fonts, wrong colors, incorrect imposition
or positioning. If a problem is found, you can modify your job
before it is approved and sent for printing.

The IC-309m print controller provides you with the following
proofing options:

● Job Preview tool—Open and preview an RTP job from the
IC-309m print controller Storage area.

● Export an RTP file as a PDF file.

● PDF preview—Use Adobe Acrobat software to open and
preview jobs from the IC-309m print controller Storage area.

See also:
Job Preview tool on page 36
Exporting an RTP file on page 36
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Job Preview tool
The Job Preview tool enables you to preview partially RIPed and
fully RIPed jobs.

The preview displays the final printed sheets and includes raster
data and layout data. The Job Preview tool includes three main
areas:

● Preview area—Displays the rasterized pages in your job, page
orientation, crop marks and fold marks, and enables you to use
magnification tools to zoom in on areas of the sheet and verify
color, trapping, or overprinting

● Layout tab—Displays the actual layout and structure of the
printed sheets, booklets, or imposed job, and provides
information about the sheet—for example, sheet size and trim
size

● Run List tab—Displays thumbnails of your job and enables you
to navigate to the various pages in the job

Finding the K values of a specific area
Use the Color Density tool in the Job Preview window to find out
the CMYK values of a specific area on the page.

A processed job must be displayed in the Job Preview window.

1. In the Job Preview window, click the Color Density  button.

2. Move the pointer to the location on the page where you want
to measure the color values and click.
The K dot percentage values and spot color K equivalent
values appear as a tool tip.

Export for Proof
The Export for Proof option enables you to create a PDF file that
can be exported and used as a soft proof. The exported file is
composed from the RTP data of the job. Only RTP files can be
exported. The exported file includes all the defined job parameters
and files exactly as they would be printed in the resulting PDF.

Exporting an RTP file
Export an RTP file, and convert it to PDF format.

Requirements:

A processed file must be in the Storage area.

Note: You cannot export partial RTP files for proofing.
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1. Select an RTP job in the IC-309m print controller Storage
area.

2. Right-click the job and select Export for Proofing.

3. Select if you want to export Pages, Booklets or All. If you
selected Pages or Booklets, enter the page or booklet
numbers and/or ranges separated by commas.

Note: If you select an imposed job, you are asked to enter the number
of Sheets instead of the number of Pages.

4. Click OK.

5. In the Export For Proofing dialog box, locate the folder in
which you want to save the file, and click Save.

The PDF file can be printed on any printer.

Verifying the content of the job
When you import a job, the IC-309m print controller automatically
performs a preflight check (in the incoming queue) on the external
components of the job and displays the results in the Preflight
report window.

The following job components are checked:

● High-resolution images or the incorrect links to the high-
resolution images folder

● Fonts
● Spot colors that are not defined in the IC-309m print controller

spot color library
● Dynamic exception commands for a file that was submitted via

a dynamic page exceptions virtual printer
● AFP resources

Note: The IPDS workflow is available only with the Trans Pack.

If the job passes the preflight check, the Preflight column in the
Storage area displays a green check mark. If the job fails the
preflight check, a red X is displayed.

The preflight report is a job-related report that provides information
about the status (missing or found) of key job components prior to
processing and enables you to correct your files accordingly. You
can review the report and resolve the missing components, and
thus save processing time without error or failed messages
constantly appearing.

If all key components are found in the preflight check, the job is
processed and printed according to the job flow that you selected.
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If the test fails (missing key elements are detected), the job is
returned to the Storage area with the preflight report available for
inspection.

Performing an extended preflight check
Checks the status of additional key components before the job is
sent for printing.

You cannot perform a preflight check on PDF files that are locked
or protected. If you attempt to do so, a message appears stating
that the file is encrypted.

1. Open the job parameters window of the job on which you want
to perform a preflight check.

2. Select Services, and then select Preflight.
3. Select the Run extended preflight check check box.

By default, Inspect the main file only is selected. (Checks
the status of the main file only, including fonts, high resolution
images, and spot colors, before the job is sent for printing.)

4. Select Inspect the main file and the external elements If
you want a check for spot colors and fonts in the external
elements to be included in the preflight check.

5. Click Submit.

The results of the preflight check are displayed in a preflight
report.

Viewing and printing a preflight report
The preflight report is a job-related report that provides information
about the status (missing or found) of key job components prior to
printing and enables you to correct your files accordingly.

If more than one preflight check is run on a job, the latest preflight
report overrides the previous one.

1. In the Storage area, right-click your job, and from the menu,
select Preflight report.

2. In the Preflight Report window, click the desired report option
—for example, HiRes—to see the results for that option.

3. (Optional) To print the report, click Print.
4. (Optional) To export the preflight report, perform the following

actions:

a. Click Export and browse to the desired location.

b. Click Save.

5. Click Close.
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Preflight report window
The Preflight Report window is opened by right-clicking your job
and selecting Preflight report.

Preflight options

Fonts The heading area lists the number of found
and missing fonts. The report body lists the
names of fonts that are found in the file, or are
missing from the Font Library.

The Source column indicates whether the font
is embedded in the file or was found in the
Font Library.

Spot Colors The heading area lists the number of spot
colors as well as the number of spot colors
missing from the dictionary. The report body
lists both the missing spot color names (spot
colors not found in the spot color dictionary),
and the found spot color names (spot colors
found in the spot color library). The Color
space column displays the alternative color
space of the spot color. N/A indicates that an
alternative color space is not defined in the
file, or the color space is not relevant.

If the spot color is Missing, the original CMYK
values that are embedded in the PostScript
file are displayed in the Values column.

If the spot color is Found, the CMYK values
that are in the spot color dictionary are used
and no values are displayed in the Values
column.

Exceptions Lists the dynamic page exception commands
found in the file

External files Lists the missing and found high-resolution
images. If wrong links to the high-resolution
images folder exist, these are also listed.
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Preflight options

AFP resources Lists the missing AFP resources and the
found AFP resources in the file.

Indicators

 Found Appears when all of the files are found for the
selected option.

 Missing Appears when key components in the job are
not found.

 Not
preflighted

Appears if no items were found for the
resource, or if the resource was not searched
for in the file, due to not selecting the
extended preflight check.

Warning Appears if you need to be aware of the item in
the report.

Show list

All Displays both missing and found options.

Found Displays options that are found.

Missing Displays options that are missing.

Submitting urgent jobs
When a job is urgent, you can submit it for processing or printing
and run it before other jobs.
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If you submit a rush job for processing while another job is being
processed, the latter job pauses temporarily but retains its running
status. When the rush job finishes processing and moves to the
print queue, the processing of the paused job continues.

If you submit a rush job for printing while another job is being
printed, the rush job moves to top of queue and begins printing
after current job is complete. .

Running a job immediately
Submit an urgent job for processing, and run it before other jobs.

Requirements:

The job must be waiting in a queue or in the storage area. If the
job is active, this option is not available.

In the queues or Storage area, right-click the job and select
Run Immediately.
The job appears with the rush status indicator at the top of the
appropriate queue and runs immediately.

Secure printing overview
The IC-309m print controller enables you to protect sensitive data
and control its printing.

Following are some of the options available:

● The Disk Wipe utility enables you to work in a more secure
environment, by permanently removing data left by files that
you have deleted.

● Password Protect Jobs (set in the Print Driver software)

● Deletion policy (set in the Preferences window)

See also:
Preferences window on page 139
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5 Managing jobs

Archiving and retrieving jobs
To keep enough disk space free, archive jobs and their related files
to an external server and then delete them from the Storage area.
You can retrieve archived jobs and files later for further use.

Archiving is a method of backing up and storing a job that enables
you to increase the available space on your disk. A cabinet file (a
compressed file) that contains all the files related to the archived
job is created at the selected location. Jobs are archived with the
information in its job parameters and its Job History windows. It is
also most useful to archive jobs that are repetitive. For example,
when the same job is run every month.

Note: The IC-309m print controller archives large jobs to several cabinet files.

When retrieved, the archived job retains the original job name, not
the name assigned when archived.

Archived jobs are an important tool for reporting and resolving
problems as they contain all the information for the service
personnel.

Archiving a job
Archive a job so that more disk space becomes available.

Requirements:

A folder for storing the archived job.

1. In the Storage area, right-click the job that you want to archive
and select Archive.

2. Locate the desired destination folder for the archive, and then
click Save.
A cabinet file (a compressed file) that contains all the files
related to the archived job is created at the selected location.

3. Delete the job from the Storage area.

Retrieving a job

You can only retrieve jobs that have been archived.

When you retrieve a job, the archived job retains the original job
name, and not the name assigned when archived. The files related



to the job (for example, PDL) are also retrieved and the cabinet file
is not deleted.

You can retrieve more than one job at a time.

1. From the File menu, select Retrieve from archive.

2. Locate the archived job under its archive name, and select the
related cabinet file.

3. Click Add.
The selected job appears in the lower list.

4. Click Retrieve.
The selected job appears at the top of the list in the Storage
area.

5. In the Job History window, verify that the file has been
successfully retrieved.

Forwarding a job to another Creo server
Requirements:

● The job that you want to forward must be in the Storage area.

The same software version need not be running on both IC-309m
print controllers. If the same software version is running on both
IC-309m print controllers, the entire job is forwarded. If the same
software version is not running on both IC-309m print controllers,
only the PDL is forwarded, not the entire job

1. In the Storage area, right-click the job, and select Forward to
> Other.

2. In the Host name / IP Address box, type the name or IP
address of the server that you want to forward the job to.

3. Click Find.

4. Select one of the following:

○ Send to Storage—to send the job to the selected server’s
Storage area.

○ Send to print—to send the job to the selected server’s
Print Queue.

5. Click Send.

Notes:

● You cannot forward a job if the operator password was changed on
the destination IC-309m print controller. From the source IC-309m
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print controller, select Start > Run and connect to the destination
IC-309m print controller. Log on using the new operator password.

● You cannot forward a job to another IC-309m print controller if files
have never been RIPed on the destination IC-309m print controller.
This might occur in rare instances—for example, if you reinstall the
system or format image disks.

Duplicating jobs
Requirements:

The job to be duplicated must be in the Storage area.

In the Storage area, right-click the job, and select Duplicate.
The selected file is duplicated and is given the name of the
original job followed by the suffix _dup.

Note: If you duplicate an RTP job, the duplicated job is in its original
format.

Accounting Viewer
The Accounting Viewer presents information about all of the jobs
successfully printed via the IC-309m print controller.

The accounting report is in the form of a tab-delimited file and
contains detailed information about the printed job. You can filter
and sort information in the report and print it. You can also export
the report to a spreadsheet application—for example, Microsoft
Excel—where you can manipulate the data. By default, all of the
jobs handled during the past 90 days are listed.

This report includes various types of information, such as the
following:

● The job's size

● The processing time

● The number of pages in the job

● The number of pages printed. This data is based on the job's
original input and the parameters that were set in the job
parameters window.

You can access the Accounting Viewer from the Info menu.

Customization of the Accounting Viewer
There are two ways to customize the Accounting Viewer table:
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● Show, hide, and move columns. This is a quick way to
customize the table. Changes that you make to the table are
not saved permanently.

● Create a customized accounting view that you can edit and
save.

Show, hide, and move columns in the Accounting
Viewer table
A quick way to customize the Accounting Viewer table is to show,
hide, or move columns.

Perform any of the following actions:

○ To move a column to another location in the table, drag the
column to where you want it.

○ To hide a column, right-click any column in the table, select
Hide, and then from the list of columns that are currently
displayed, select the column that you want to hide.

○ To display a column, right-click any column in the table,
select Show, and then from the list of columns that are
currently hidden, select the column that you want to
display.

Creating a customized view in the Accounting Viewer
Create an accounting view for specific needs by selecting columns
in the Accounting Viewer and saving your selections as a
customized view.

1. From the Info menu, select Accounting.
The Accounting Viewer window appears.

2. Next to the View list, click the browse (...) button.

3. In the Views window, click Add (+).

4. In the View name box, type a name for the view that you want
to add.

5. In the Based on list, select the view that you want to base the
new view on.

6. Click OK.
The new view is added to the Views area, and the names of
the columns on which the view was based appear selected.

7. Select the columns that you want to display in the new view.

8. Using the arrow buttons, move the names of the columns up
and down until the columns are arranged the way you want
them.
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9. Click OK.

You can select the customized view in the Accounting Viewer, in
the View list.

Record deletion from the Accounting Viewer table
There are two ways to delete accounting records from the
Accounting Viewer table:

● Clear all—Click the Clear all button in the Accounting Viewer.

● Clear Accounting Log—This is a quick way to delete all of the
accounting records without having to open the Accounting
Viewer.

Deleting records from the Accounting Viewer table
Delete records from the Accounting Viewer in either of two ways.

1. Perform one of the following actions:

What do you want to do? Here's how to do it

Open the Accounting Viewer and
delete all accounting records

a. In the IC-309m print
controller workspace, from
the Info menu, select
Accounting > Accounting
Viewer.

b. Click Clear all.

Delete accounting records without
opening the Accounting Viewer

In the IC-309m print controller
workspace, from the Info menu,
select Accounting > Clear
accounting log.

2. In the Clear all accounting data dialog box, click Yes.

Exporting the accounting log
Export and save the accounting log in a specified location.

Requirements:

Create a folder for exporting the accounting log.

The accounting log includes all of the columns, listed in the
original order and sorting. The data that you export is not deleted
from the accounting report (that is, it will still be displayed in the
Accounting Viewer ). After you save the file, you can manipulate
the data in a text editor, or in a spreadsheet application—for
example, Microsoft Excel.
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1. From the Info menu, select Accounting.

2. In the Accounting Viewer, filter the information as desired.

3. Click Export.

4. Locate the folder in which to save the report.

5. (Optional) Change the file name.

6. From the Files of Type drop-down list, select the file type to
export.

7. Click Export.

Click Print List to print the accounting information (filtered and
sorted) to any connected printer.

Job report
The Job report window contains all of the information from the job
parameters window for a specific job. The Job report window
presents the job parameters in a single window that can be printed
or exported as a text file.

Display the Job report window by right-clicking a job in the
Storage area and selecting Job report.

Click Print to print the job report to any printer.

Exporting the job report
The job ticket report contains all of the information from the Job
Parameters window (including Job Parameters window title bar
data). The Job Ticket report presents the job parameters on a
single sheet and may be exported.

1. In the Storage area, right-click the desired job, and select Job
report.

2. Click Export to export the report as a text file.

3. Locate the folder in which to save the report.

4. In the File name box, type a name for the file.

5. Click Save.

The job report is saved as a text file in the specified location.
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6 Managing color

Color management on the IC-309m print controller
Color management is a series of steps taken to ensure that colors
are accurate and repeatable when transferred from one device to
another. These steps enable you to reproduce the color conceived
by a graphic artist or photographer as closely as possible on a
monitor, a proof, or the sheet.

Although the IC-309m print controller drives monochrome printers,
it uses these same color management steps to take the input color
space and convert it into the printer's black color space..

The IC-309m print controller enables you to use these tools to
adjust and improve the color quality in your jobs:

● Spot Color Editor, which enables you to edit the CMYK values
of every spot color in the Spot color dictionary.

● Gradation Tool, which enables you to create and edit gradation
tables to perform tone corrections on your printed output.

IPDS and AFP color management
Note: The IPDS workflow is available only with the Trans Pack.

When you are working in IPDS mode, the IPDS data is handled
according to the Color Management Object Content Architecture
(CMOCA), as defined by the AFP Color Consortium (AFPCC).

The IC-309m print controller applies color management options for
each IPDS data object according to the Color Management
Resources (CMR) that are included in the IPDS data
stream.Although the IC-309m print controller drives monochrome
printers, it still applies color management options for each IPDS
data object according to the Color Management Resources (CMR)
that are included in the IPDS data stream.

This also applies to AFP files processed in file submission mode.

Note: You can override the CMOCA settings and make additional
adjustments to the color settings in the IPDS printer setting or in the AFP tab
of the virtual printer.



Profiles
Profiles are used to reproduce color from one device’s color space
to another device's color space in a consistent manner. They
provide the necessary information to convert color data between
device-dependent color spaces and device-independent color
spaces. You use profiles to color-manage your system.

A source profile defines the RGB or CMYK color space of the
object’s source, providing information such as the white point,
gamma, and type of phosphors used. A destination profile defines
the gamut of an output device, such as a printer. The IC-309m
print controller uses a device-independent color space to translate
between the source color space and the black color space of the
output device, which you cannot change.

Managing profiles
The Profile Manager enables you to import and manage source
profiles on the IC-309m print controller.

Importing a source profile
Import a source CMYK or RGB profile to emulate other devices or
color spaces.

1. From the Tools menu, select Resource Center.
The Resource Center window appears.

2. In the Resource list, select Profile Manager.

3. Click the Import button.
The Import Source ICC Profile window appears.

4. In the Source profile area, click the Browse button.

5. Locate and select the required source profile, and then click
Open.
The new emulation name is displayed in the Emulation name
box.

6. (Optional) Change the name of the emulation.

7. Click Import.
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8. Click Close to close the Resource Center.
The new source ICC profile is added to the Color flow tab in
the job parameters window.

Spot Color Editor overview
A spot color is a specially mixed ink that you can use to reproduce
colors that are difficult to reproduce with CMYK inks.

Individual job pages can contain RGB, CMYK, and spot color
elements.

The IC-309m print controller Spot Color Editor enables you to edit
the values of every spot color in the spot color dictionary. The
IC-309m print controller in turn translates these CMYK values to K
values only.The edited spot color is saved in a custom dictionary.
When the IC-309m print controller identifies a spot color in a job, it
looks for the name of the spot color in the Spot Color Library
according to the settings in the Job Parameters for that specific
job. If the setting for spot colors in the Job Parameters file is:

● Spot Library—The IC-309m print controller looks for the name
of the spot color in the Spot Color Library in the following
sequence:

○ Custom global library

○ Predefined global library

○ Original CMYK File values

● Original CMYK File values—The IC-309m print controller
uses the Original CMYK File values.

Note: Some PANTONE colors in the PANTONE PLUS color dictionary have
the same name as PANTONE colors in the legacy PANTONE color
dictionary. Therefore, in the Spot Color Editor the word Plus was added to
PANTONE PLUS color names to help you distinguish between colors in the
two libraries. In the job parameters windows, there is an option to select the
PANTONE Plus library or the Legacy PANTONE library.

See also:
Adding a spot color - Global Library on page 52
Editing a spot color - Global Library on page 52
Deleting a spot color - Global Library on page 53
Protecting specific colors on page 53
Monochrome tab in the job parameters window on page 122
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Adding a spot color - Global Library
1. From the Tools menu, select Spot Color Editor.

2. In the Spot Color Editor dialog box, click Add.

3. Type the new color name as it is in the original file.

Note: The spot color names are case sensitive and should match the
names that appear in the original file.

4. Change the CMYK values, displayed on the right side of the
Spot Color Editor window, as required.

5. Click Save.

6. Click Close.

The new color is added to the custom dictionary.

If you created a new spot color for an RTP job, re-RIP the job
before printing.

Editing a spot color - Global Library
1. From the Tools menu, select Spot Color Editor.

2. Perform one of the following actions:

○ In the Color list, search for the desired color.

○ In the Spot color library list, select the color dictionary that
contains the color that you want to edit.

Note: Use the PANTONE C dictionary if you are working with an
application such as Adobe InDesign.

3. Select the required color.
The color's CMYK values and color preview appear on the
right side of the Spot Color Editor window.

4. Change the CMYK values as required.

5. Click Apply.
The new color is added to the custom dictionary.

6. Click Close.
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Deleting a spot color - Global Library

You can delete spot colors from the custom color dictionary.

1. From the Tools menu, select Spot Color Editor.

2. Select the Spot color tab.

3. In the Spot color library list, select Custom Dictionary.

4. From the list of custom colors, select the color that you want to
delete.

5. Click Remove.

6. Click Yes to delete the color.

7. Click Close.

Protecting specific colors
Using the Spot Color Editor, you can protect specific colors—for
example, official logos or company colors—to help produce color
fidelity and color consistency between devices. When you define a
specific color as an RGB, CMYK, or gray spot color and enter a
fixed CMYK target for it, the IC-309m print controller treats the
selected color as a spot color and protects it. The IC-309m print
controller in turn takes the protected color and translates it to a K
value.

Protecting an RGB color as a spot color
The RGB spot workflow applies to graphic and text elements.

1. From the Tools menu, select Spot Color Editor.

2. In the Spot Color Editor dialog box, click the Protect RGB tab.

3. Click Add.

4. In the Color name box, type a name for your color.

5. In the RGB source values column and the CMYK target
values column, type the desired values, or select a spot color
from Entire Predefined List.

6. Click Save.

7. On the Protect RGB tab, select the color.
The color information appears.

8. If necessary, in the Corrected column, adjust the CMYK
values.

9. Click Apply.
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10. To apply this to your job, in the job parameters window, in the
Color tab, select Protected Colors, and then select the Use
protected RGB values check box.

Protecting a gray color as a spot color
The gray spot workflow applies to graphics and text elements.

1. From the Tools menu, select Spot Color Editor.

2. In the Spot Color Editor dialog box, click the Protect Gray tab.

3. Click Add.

4. In the Color name box, type a name for your color.

5. In the Gray source value column and the CMYK target
values column, type the desired values, or select a spot color
from Entire Predefined List.

6. Click Save.

7. On the Protect Gray tab, select the color.

8. If necessary, in the Corrected column, adjust the CMYK
values.

9. Click Apply.

10. To apply this to your job, in the job parameters window, in the
Color tab, select Protected Colors, and then select the Use
protected gray values check box.

Protecting a CMYK color as a spot color
The CMYK spot workflow applies to graphic and text elements.

1. From the Tools menu, select Spot Color Editor.

2. In the Spot Color Editor dialog box, click the Protect CMYK
tab.

3. Click Add.

4. In the Color name box, type a name for your color.

5. In the CMYK source values column and the CMYK target
values column, type the desired values, or select a spot color
from Entire Predefined List.

6. Click Save.

7. On the Protect CMYK tab, select the color.

8. If necessary, in the Corrected column, adjust the CMYK
values.

9. Click Apply.
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10. To apply this to your job, in the job parameters window, in the
Color tab, select Protected Colors, and then select the Use
protected CMY values check box.

Color adjustment with the Gradation Tool
Sometimes you need to perform tone corrections when you print a
job. You can use the Gradation Tool to create and edit gradation
tables, and then apply these tables to your printed output. Before
you send your job to print, preview your processed job in the
Gradation Tool window, and check the effect of your gradation
tables on your job. Changes in gradation can include changes to
the brightness and contrast .

The default gradation table, DefaultGradTable, serves as a
baseline and consists of a 45° gradation curve, with brightness
and contrast set to 0 and contrast center set to 50.

Creating and editing a gradation table
Correct gradation, brightness, and contrast in RTP files, and
preview your changes before you send your job to print.

1. From the Tools menu, select Gradation.

2. Next to the Preview File box, click Browse.

3. Select the job that you want to preview, and then click Open.
The Gradation Tool window appears with the Before and
After views displaying your job.
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4. Click the curve in the graph to add a point, and then drag the
point to modify the separation.
The value appears in the Input or Output boxes.

5. To remove a point on the curve, select the point and then click
Remove.

6. To reset the gradation curve to a 45° curve, click Reset.

7. To revert to the original gradation settings, click Revert.

8. To remove the last change you made to the gradation graph,
click Undo.

9. To edit the brightness or contrast, move the slider.

10. To view gradation changes in your job, click Refresh.
Changes are automatically applied to the displayed image in
the After view.

Note: When you change gradation table definitions in the Gradation
Tool and click Refresh, you can see that the changes have affected the
image in its entirety. Despite what you see in the After view, changes
made to the gradation tables do not affect spot colors.

11. Click Save .

12. In the Table name box, type the name of the new gradation
table.

13. Click OK.
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The gradation table is saved and added to the Gradation Table
list on the Color Adjustments tab in the job parameters window.
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7 Production workflows

Printing using imposition

Imposition overview
Imposition is the process of positioning page images on a sheet of
paper so that when a printer or digital printing press prints the
sheet, the page images will be in the right order. It is part of the
process of producing finished documents.

In addition to page images, you can add various marks to the
sheets to aid the production process. These marks show where the
paper should be folded or trimmed.

Imposition does not affect the content of the individual page but
rather affects only the placement of the page images on the sheet.
Imposition is a combination of content and layout. The content
consists of the pages that should be printed, and the layout is the
location of the page on the sheet, along with the page’s printing
marks, crop marks, and fold marks.

Note: You can impose IPDS jobs by creating an IPDS virtual printer with the
appropriate imposition settings.

See also:
Imposition tab in the job parameters window on page 114

Imposition methods
The IC-309m print controller provides several imposition methods.

Imposition method Description

Step and repeat This method is the most efficient one when you want
to print multiple copies of the same image and fill
each sheet to capacity—for example, many business
cards on one sheet.



Imposition method Description

Step and continue This method enables you to place different pages of
a job on one sheet so that the sheet is filled to
capacity.

Cut and stack This method is used to print, cut, and stack pages
while preserving a certain order. When the cut stacks
are piled one on top of the other, the entire job ends
up in the desired order. The cut-and-stack method is
useful primarily for high-volume variable information
jobs.

Saddle stitch This method prints pages in a manner that is suited
for saddle-stitch binding. With this binding method,
sheets are folded, inserted one inside another, and
then stitched or stapled along the spine, such as in a
brochure or magazine.

Perfect bound This method prints pages in a manner that is suited
for perfect binding. Perfect binding is a book-finishing
technique in which the folded sheets are gathered in
order and clamped into place. A saw roughens the
spine edge of the gathered pages. Glue is then
applied to the spine, and the cover of the book is
affixed to the glued spine. This method is used for
most books.

Nested saddle
stitch

This sub-method of perfect
bound combines the saddle-
stitch imposition method and
the perfect bound imposition
method. As with saddle
stitching, pages are grouped
together and stapled or
stitched across a common
center fold. The saddle groups
are then stacked side-by-side
and glued, as with perfect
binding.

Note: This option is not
applicable to VDP jobs.
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Imposition method Description

Folded signatures A signature is a large printed sheet of paper folded
many times to form a section of a book, magazine, or
pamphlet. As a unit, the signature usually contains
from four to ninety-six pages, usually in multiples of
four pages—for example, 4, 8, 16, 32, and so on.
The size of the starting sheet depends on the
number of pages in the signature.

Previewing an imposition layout
View your imposition layout and settings.

Requirements:

An imposition method must be selected.

You can open the Preview window at any time and keep it open to
check your imposition settings as you select them. The Preview
window displays either a schematic representation of your
imposition layout or a thumbnail view of the job. The preview
dynamically reflects any changes that you make.

1. Open the job parameters window for the desired job.

2. Click the Imposition tab, and make sure that an imposition
method has been selected.

3. Click the Preview button.
The Preview window appears.
The Preview window includes the following buttons (selectable
at the top of the window) that enable you to select the view
you want displayed:

● Layout view—shows the layout view of the imposition.

● Thumbnail view—shows a thumbnail of the imposition.

● F—shows the front view of the selected view (layout or
thumbnail).

● B—shows the back view of the selected view (layout or
thumbnail).

● FB—shows the front and back view of the selected view
(layout or thumbnail).

If the imposition you are previewing has more than one page,
there are also buttons at the top of the window that enable you
to page through the imposition.

4. After previewing, click the Close button.
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Printing a business card job
Use the step-and-repeat imposition method to print multiple copies
of the same business card on one printed sheet.

Requirements:

This example assumes that your job contains one-sided business
cards that are 50 mm × 90 mm or 1.96 in. × 3.54 in., imposed on
A3 or Tabloid paper.

1. Click the suspend button to suspend the Process Queue.

2. From the File menu, select Import.

3. Import your business card file to the Print virtual printer.
The file is imported to the Process queue with a Waiting
status.

4. In the suspended Process queue, double-click the business
card file.
The job parameters window appears.

5. In the job parameters window, under Print, select the Paper
Stock tab.

6. Choose Paper Name, and in the Paper size list, select 11 x
17 or A3.

7. Click the Imposition tab.

8. In the Imposition method list, select Step & Repeat.

9. Select the Size tab.

a. For Trim size, select Custom.

b. For H, type 1.96 inches or 50 mm.

c. For W, type 3.54 inches or 90 mm.

A preview of the layout is displayed below.

10. For Trim orientation, make sure that the Landscape option
is selected.

11. Select the Templates parameter, and set the values as
follows:

a. In the Layout list, select Best Fit.
The IC-309m print controller determines how many
business cards can fit on each sheet and calculates the
best fit.

b. For Print method, make sure that Simplex is selected,
because your business cards are one-sided.
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12. Click the Preview button to preview the layout.
The Preview window appears, displaying a schematic
representation of your imposition layout.The layout of three
columns by eight rows appears with no imposition conflict.

13. Leave the Preview window open, and, if necessary, drag it to
the right.

14. Select the Marks parameter.

15. In the Marks list, select Crop marks.
The crop marks automatically appear in the Preview window
and the Margins setting is automatically increased to
accommodate the crop marks.

16. In the Gutter box, type 0.2 inches or 5 mm.
The new gutter size automatically appears in the Preview
window. The IC-309m print controller calculates that to
accommodate a gutter of 0.2 inches or 5 mm, a layout of three
columns by seven rows will best fit on each sheet.

17. Check the Preview window to make sure that no imposition
conflicts appear.

18. In the job parameters window, click Save.

19. Release the suspended Process Queue.
Your business cards are processed and printed according to
the imposition settings.

Printing a saddle-stitch job
Use the saddle-stitch imposition method to print two sets of the
same job on one printed sheet to save paper and production time.

Requirements:

This example assumes the following:

● Your job is an eight-page brochure, with a custom trim size of
5.27 by 3.34 inches, or 134 by 85 mm.

● Tabloid or A3 paper is loaded in the printer.

1. In the Storage area, double-click your job.

2. In the job parameters window, click the Imposition tab.

3. In the Method list, select Saddle stitch.

4. In the Sets per sheet list, select 2 to print two sets of your
imposed job on one printed sheet.

5. Click the Marks parameter.

6. In the Marks list, select Crop marks.
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7. Change the position of the marks on the image by adjusting
the values in the Horizontal Offset and Vertical Offset
boxes.

8. In the Mark color list, select the color for the mark.

9. Click the Spacing parameter.

10. In the Spacing area adjust the values for:

● Margins
● Horizontal gutter
● Vertical gutter
● Spine

11. In the Custom bleed size box, type 0.118 inches or 3 mm.

12. Click the Preview button.
The Preview window appears, displaying a schematic
representation of your imposition layout.

13. Close the Preview window.

14. Click Submit.
Your job is processed and printed according to the imposition
settings for two sets per sheet. You have used most of the
sheet's space and saved on paper. You can also easily cut
and staple the two brochures.

Printing a nested saddle-stitch job
Use the nested saddle-stitch imposition method to print a book.

● This example assumes that your job is a 120‑page book with a
trim size of 8.2 by 11.0 inches. Each booklet will include four
sheets (16 pages).

● Create a finishing mark set to determine where the finisher will
cut.

1. In the Storage area, double-click your job.

2. In the job parameters window, click Print, and then click the 
Paper Stock parameter.

3. In the Paper Name list, select the paper name for your job.

4. Click the Imposition method parameter.

5. In the Methods list, select Perfect Bound.
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6. Select the Nested-Saddle-Sheet per group check box, and
type 4.

Note: You might have blank pages in the last booklet of your job. The
number of blank pages depends on how many pages are in the entire
job, and how many sheets you set per group.

7. (Optional) Click Preview to preview the layout and page
sequence of your job, and then click Close.

8. Click the Templates parameter.

9. In the Layout list, select Custom.

10. In the Columns list, select 2.

11. In the Rows list, select 1.

12. Click the Marks parameter.

13. In the Marks list, select Crop & fold marks and select the
Both sides check box.

14. In the Marks color list, select a color for the marks that will be
placed on the printed sheets.

Note: If you want to place marks on a job that has a dark bleed, select
white or gray for the marks color.

15. Click the Creep parameter.

16. In the Creep in area, select Auto.

17. Click the Finishing tab, and then click the Marks and
barcodes parameter.

18. Click Add.

19. In the Mark Set column, select the mark set you created in the
Resource Center.

20. To print the finishing marks on every sheet, in the Selection
Type column, select All.

21. Suspend the Print Queue and then click Submit to process
your imposed job.

22. In the Storage area, right-click your job, and select Job
Preview.

Printing a folded signature job
Use the folded signature imposition method to print a book.

Requirements:
● This example assumes that your job is a book with a trim size

of 8.2 by 11.0 inches.
● Create a finishing mark set to determine where the finisher will

cut between each signature.
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1. In the Storage area, double-click your job.

2. In the job parameters window, click the Print tab, and then
click the Paper Stock parameter.

3. In the Paper Stock list, select the paper name for your job.

4. Click the Imposition tab, and then click the Imposition
method parameter.

5. In the Methods list, select Folded Signature.

6. Click the Templates parameter.

7. In the Layout list, select 16 Pg. Booklet Type7.

8. Click Preview.

9. Click Thumbnail view, and verify that there are no imposition
conflicts.

10. Click Close.

11. Click the Marks parameter.

12. In the Marks list, select Crop & fold marks and select the
Both sides check box.

13. In the Marks color list, select a color for the marks that will be
placed on the printed sheets.

Note: If you want to place marks on a job that has a dark bleed, select
white or gray for the marks color.

14. Select the Print hairline where sheet folds check box.

15. Click the Signature Marks parameter.

16. In the Mode list, select Auto.

Note: Signature marks print marks along the spine of the book, and help
to assemble printed signatures for binding in the correct order.

17. Click the Finishing tab, and then click the Marks and
barcodes parameter.

18. Click Add.

19. In the Mark Set column, select the mark set you created in the
Resource Center.

20. To print the finishing marks on every sheet, in the Selection
Type column, select All.

21. Suspend the Print Queue , and then click Submit to process
your imposed job.

22. In the Storage area, right-click your job, and select Job
Preview.
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Folded signature templates
The Imposition Template Builder provides many folded signature
templates.

The templates that you choose determine how the signature sheet
is folded.

Note: When duplicating and editing a predefined folded signature template,
pagination might reset after editing. Make sure that the pagination is as
expected in the Imposition template viewer section.
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Imposition Template Builder tool

Imposition Template Builder overview
The Imposition Template Builder is available only with the Action
Pack.

The Imposition Template Builder enables you to define all
imposition settings without having to adjust imposition parameters
in the job parameters window. After you save a template in the
Imposition Template Builder, you can apply it to a specific job
using the Imposition tab in the job parameters window. The
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IC-309m print controller automatically updates the imposition
settings in your job according to the selected imposition template.

In addition, when you create a template, the IC-309m print
controller publishes the list of imposition templates via JMF. Via
JDF, you can then select the desired imposition template by
specifying the imposition template name.

Creating an imposition template
Use the Imposition Template Builder to create an imposition
template. The Imposition Template Builder is available only with
the Action Pack.

The Imposition Template Builder tool enables you to select the
imposition method for which you want to create a template, and
then define all the parameters for the selected imposition method.
There are seven tab in the Imposition Template Builder, and the
options in each tab vary according to the imposition method
selected. A detailed list of all the available options can be found in
the section Imposition tab in the job parameters window.

1. From the Tools menu, select Imposition Template Builder.
The Imposition Template Builder appears and displays tabs
that enable you to define all of the required imposition
parameters for your new template.
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2. In the Method list, select an imposition method.
You can select from the following methods:

● Saddle Stitch—A book-finishing technique in which the
pages of a book are attached through stitching or stapling
in the spine fold—for example, in brochures.

● Perfect Bound—A book-finishing technique in which the
spine fold is trimmed and the edges of the gathered pages
are roughened and glued together—for example, in
hardcover books.

● Step and Repeat—A technique in which multiple copies of
an image are printed to fill up a large sheet. This method is
used mainly for business cards.

● Step and Continue—A technique in which different pages
of a job are printed on one sheet according to the selected
layout, so that the sheet is filled to capacity.

● Cut and Stack—A book-finishing technique in which jobs
are printed, cut, stacked, and bound in the most efficient
manner to preserve the original sorting. A job's pages,
booklets, or books are sorted in a Z-shape, (each stack of
pages is sorted in consecutive order). When stacks are
piled one on top of another, the entire job is already sorted
up or down.

● Folded Signature—A technique in which a large sheet is
folded several times to form a section of a book, a
magazine, or a pamphlet.

3. Click New.

4. Type the name of the new template, and press Enter.
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5. In the Layout area, type the number of columns and number
of rows that you need.

Note: The imposition method that you select determines the number of
columns and rows that you can enter. For saddle stitch and perfect
bound, you can place up to 64 pages on one sheet (8 × 8). For step and
repeat and step and continue, you can place up to 625 pages on one
sheet (25 × 25).

6. In the Type list, select Simplex or Duplex.

7. In the Orientation list, select Portrait or Landscape.

8. In the Binding list, select the appropriate binding method.

Note: Binding is available only when Saddle Stitch or Perfect Bound
imposition methods are selected.

9. (Optional) In the Description box, type a name for the
imposition template.
The description name is the name that is used when the
imposition templates are published via JMF.

10. (Optional) Depending on the imposition method and the
template required for your specific jobs, you can continue
defining imposition parameters in the following other tabs:

● Advanced Layout
● Sizes
● Marks
● Spacing
● Creep
● Signature Marks

Note: The options in each tab varies according to the imposition method
selected. A detailed list of all the available options can be found in the
section Imposition tab in the job parameters window.

11. Click Save.

See also:
Imposition tab in the job parameters window on page 114

Imposition template viewer window
The Imposition Template Builder is available only with the Action
Pack.

As you create or modify a template, you can see your template in
the template viewer. As you select parameters, the template
viewer dynamically changes to reflect your selections.
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Note: For the Cut&Stack imposition method, a Step & Repeat pagination is
displayed. When applied to a job, a correct pagination preview is displayed,
in the Job Parameters window.

Buttons

Notes:

● When Simplex is selected, only the Front view is available.

● Sheet size is set on the Imposition tab. The sheet size that appears in
the template viewer is dynamic. It changes to accommodate the
parameters that you choose.

Front
Displays the front pages.

Back
Displays the back pages.

Both
Displays both the front and back pages
simultaneously.

Rotate 180°
Rotates one or more pages 180°.

Rotating a page 180°

The Imposition Template Builder is available only with the Action
Pack.

Use the template viewer to rotate one or more pages 180°.
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1. Make sure that the Apply changes to front and back check
box is clear.

2. Select the desired page.

Note: To select multiple consecutive pages, click the first page, press
and hold Shift, and then click the last page. Select multiple non-
consecutive pages by pressing and holding Ctrl as you click each page.

The gray arrow on each page indicates the top of the page.
The page number is indicated by the number that appears on
each page.

3. Click Rotate 180°  .

Rotating both the front and back sides of a page 180°

The Imposition Template Builder is available only with the Action
Pack.

Use the template viewer to rotate both the front and back sides of
one or more pages 180°.

1. Select the desired page.

2. Select the Apply changes to front and back check box.

3. Click Rotate 180° .

Changing the position of a specific page on the press sheet

The Imposition Template Builder is available only with the Action
Pack.

Use the template viewer to change the location of a page. This is
often necessary when the step-and-continue imposition method is
selected.

1. Click the target location that you want to move a page to.
The target location turns blue.
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2. Click the Page Number box, and type the number of the page
that you want to move to the target location.

3. Press Enter.
The page moves to its new location.

Note: The page that was previously in the target location is not
automatically moved to another location. To retain this page, manually
move it to a new location.
If you have a duplex template and the Apply changes to front and
back check box is selected, the page number for the back side of the
page also changes when you move the page to a new location.

Simulating a job with your template
Check how a job from the Storage area looks if you apply an
imposition template to it. The Imposition Template Builder is
available only with the Action Pack.

Note: The imposition template parameters are not actually applied to the job
—you see only a simulation of how the job will look if this template is
selected on the Imposition tab.
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1. In the Imposition Template Builder window, click the Simulate
button.

2. Click Browse.

3. Select a job, and then click Select.
The parameters of the job appear with their values in the
Simulate Imposition window.

4. Change the parameters as desired.

5. Click View Simulated Job.

The Preview window appears. A simulation of the job is displayed
with the current imposition template applied.

Printing with mixed media

Mixed media overview
The IC-309m print controller enables you to print complex
documents that contain paper of varying size, coating, weight, and
so forth.

There are different types of mixed media jobs. A mixed media job
can include commands embedded in the file, such as dynamic
page exeptions, or you can manually program the media print
parameters for a range of pages in a job.

Page exceptions are special pages within a job for which you
assign different media print parameters. For example, you can
assign different media for each chapter in a book. Inserts are
blank pages of a selected media that are inserted in a job in a
specified location. For example, you can add blank pages between
sections within a brochure.

Dynamic page exceptions are page exceptions or inserts that are
embedded in the file. These files use setpagedevice keys to
indicate that the printer must switch media during the printing of a
job. When a job is RIPed, the IC-309m print controller identifies
the keys or commands and maps them to the selected types of
paper. The printer then uses those types of paper for the job. The
IC-309m print controller supports dynamic page exceptions for the
following file formats:

● PostScript
● VPS
● PPML

The method that you choose to print these documents depends on
the type of document that you want to print.
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What type of document do you
want to print?

Use this option in the job
parameters window

Mixed size Parameters from file

Mixed size with predefined tabs Parameters from file

Mixed media Exceptions

Dynamic page exceptions Exceptions from file

Creating a rule set for mapping dynamic page exceptions
Create a set of rules that maps dynamic page exceptions to the
paper stock parameters or input tray in the job parameters
window. Creating rules for using dynamic page exceptions is
available only with the Action Pack.

Requirements: A file with embedded setpagedevice keys.

The IC-309m print controller supports the following
setpagedevice keys:

● MediaType
Note: There is an option in the Preferences window to determine whether
MediaType is automatically mapped to Media Type or to Paper Name
when not using a rule set.

● MediaColor
● MediaWeight
● PageSize
● MediaPosition

1. From the Tools menu, select Resource Center.

2. In the Resource list, select Exception Mapping Rules.
The Exception Mapping Rules window appears.

3. To create a new set, perform the following steps:

a. Click the Add button.

b. Type a name for the set.
The new name appears in the Sets list.
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4. Define a new rule according to the setpagedevice keys found
in your file.

What do you want to do? Here's how to do it

Map MediaType,MediaColor,
MediaWeight, or PageSize keys
to the paper stock parameters in
the job parameters window.

a. On the Paper Name tab,
click the Add New Rules
button.

b. In the Add New Rule dialog
box, in the From file area,
select the setpagedevice
keys defined in your file.

c. In the Map to area, in the
Paper Name list, select the
paper stock that you want to
use for printing.

d. Click OK to add the new rule
to the set.

Map the MediaPosition key to
the input tray in the job
parameters window.

a. On the Input Tray tab, click
the click the Add New Rules
button.

b. In the Add New Rule dialog
box, in the From file area,
type the media position
value defined in your file.

c. In the Map to area, in the
Input Tray list, select the
input tray that you want to
use for printing.

d. Click OK to add the new rule
to the set.

5. Click Close to close the Resource Center.

Next: You can assign a rule set to your job in the job parameters
window by selecting Exceptions > Exceptions From File >
Select Rule Set.

Printing dynamic page exceptions
After creating a set of rules to map a file that includes dynamic
page exceptions, you now need to assign the rule set to your job.

Requirements: The required paper sizes must be loaded in the
trays.
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1. In the Storage area, double-click your job.

2. Click Exceptions, and then click Exceptions From File.

3. In the Select Rules Set list, select the rule set that you
created for your file.

4. (Optional) To verify or edit the mapping for the dynamic page
exceptions, click File mapping.
The File mapping results window appears. For each
parameter that was defined in the file, a pass or fail icon
indicates whether the mapping was successful.

5. (Optional) To edit the mapping results, perform any of the
following steps:

a. To select a different paper stock, in the Paper ProfileName
column, click the paper name that you want to change and
in the list that appears select a new paper name.

b. To change the print method, in the Print method column,
click the print method that you want to change and in the
list that appears select a new print method.

c. To change the tray, in the Tray column, click the tray that
you want to change and in the list that appears select a
new tray.

d. Click OK.

6. Click Submit to send your job for printing.

Printing a file with mixed paper sizes
Print a file that includes two or more different paper sizes, or
predefined tabs.

Requirements:
Note: The IC-309m print controller favors processing jobs for Long Edge
Feed (LEF) paper orientation over Short Edge Feed (SEF) paper orientation,
unless you specifically requests SEF. For example: when both Letter
(8.5x11) (LEF orientation) and Letter (8.5x11) S (SEF orientation) are
loaded, the IC-309m print controller processes the job as Letter (8.5x11), and
not Letter (8.5x11) S. If you want to process the job as Letter (8.5x11) S,
explicitly set Letter (8.5x11) S as the paper size in the Job Parameters
window.

The required paper sizes must be loaded in the trays.
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1. In the Storage area, double-click your job.
The job parameters window appears.

2. Under Print, click Paper stock.
The Parameters from file option is selected by default.

Note: The IC-309m print controller automatically maps the paper sizes
that are defined in the file to the paper that is loaded in the trays. The
first paper size that is found in the file appears in the Paper size list.

3. (Optional) To verify the mapping results, click File mapping.
The File mapping results window appears. For each
parameter that was defined in the file, a pass or fail icon
indicates whether the mapping was successful. In addition, file
information, such as paper size and paper weight, appear in
the From file column. The Paper name column, Print
method column, and Tray column display the mapping
results according to the printer resources.

4. (Optional) To edit the mapping results, perform any of the
following steps:

a. To select a different paper stock, in the Paper name
column, click the paper name that you want to change and
in the list that appears select a new paper name.

b. To change the print method, in the Print method column,
click the print method that you want to change and in the
list that appears select a new print method.

c. To change the tray, in the Tray column, click the tray that
you want to change and in the list that appears select a
new tray.

d. Click OK.

5. In the job parameters window, click Submit.

Setting custom page exceptions via the job parameters window
Set custom page exceptions when you want to specify different
media print parameters for a range of pages, add a front cover or
back cover, or insert blank media between pages.
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1. In the Storage area, double-click your job.
The job parameters window appears.

2. Click Exceptions.

3. Click Add (+) and then select the type of page exception that
you want to add—for example, Front cover.

4. In the Advanced Options window, you can define print options
for the page exceptions that you are assigning to your job by
performing the following steps:

a. To specify a different print method, click Print method.

b. To select a different paper name, click Paper Stock.

c. To shift the position of the image, click Image alignment

d. To rotate the page 180°, click Layout.

e. To select different finishing options, click Finishing.

Note: This option is only available when you select Split to Sets.

f. Click Save.

The page exceptions are added to the Exceptions list.

5. Click Save to close the job parameters window.

Working with the Creo Server Tabs plug-in for
Acrobat

Tabs plug-in overview
The Tabs plug-in is a Creo plug-in, developed for use with Adobe
Acrobat. The Tabs plug-in enables you to create and place tabs in
your unprocessed job (PDF or PostScript), manage the tab and
text attributes, and save a set of attributes for future use.
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Tabs plug-in window

Text attributes - tabs

Tabs
Size

The size of the tabbed sheet. By
default, the tab size for letter jobs is set
at 9 × 11, and for A4 jobs to A4+.

Type

The number and type of tabs that you
can select.

Note: If you want your tabs to be reversed—
that is for the lowest tab to be the first one—
select one of the reverse tab options.

Orientation

Orientation of the tab.

Top Offset

The value for the distance between the
upper edge of the paper and the upper
edge of the uppermost tab.

Note: The units in the Tabs plug-in are set in
the Acrobat Preferences dialog box.

Bottom Offset

The value for the distance between the
lower edge of the paper and the lower
edge of the lowest tab.
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Text attributes - tabs

Length

The length of the tab.

Width

The width of the tab.

Text attributes - text

Text
Font

The font for the tab text.

Size

The font size for the tab text.

 Color

The color of the tab text.

 Bold

Bolds the tab text.

 Italic

Makes the tab text italic.
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Text attributes - text

 Underline

Underlines the tab text.

Alignment

The alignment of the tab, according to
the orientation of the tab. The
orientation that you select determines
the alignment buttons that are
displayed.

●  Align Left Portrait

●  Align Center Portrait

●  Align Right Portrait

●  Align Left Landscape

●  Align Center Landscape

●  Align Right Landscape

Offset

The value that adjusts the offset of text
on the tab. The x value moves the text
horizontally. The y value moves the text
vertically.

Wrap text

Automatically wraps the text onto the
following line when the entire text does
not fit on one line.

Text on both sides

The same text appears on both sides of
the tab.
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Text attributes - text

Direction

Direction of the text.

●  Vertical

●  Counter-clockwise

●  Clockwise

Note: The Direction options are available
only for portrait jobs.

Content

# The tab number.

Before Page The page number that the tab precedes.

Text The text that appears on the tab.
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Content

Thumbnails
area A thumbnail view of the job with page

numbers and tabs indicated.

Remove Removes the selected page or tab.

Settings

Saved Settings Lists the saved settings files.

Save Saves the currently selected settings in a file.
This settings file can be applied to other PDF
or PostScript files.

Delete Deletes the selected settings file.

Adding tabs to a file
Requirements:

You can only add tabs to a PDF file or PostScript file.

Note: A portrait tab printing job usually requires single reverse-collated tab
paper, whereas a landscape tab printing job requires single straight-collated
tab paper.

1. In the Storage area, right-click your unprocessed job, and
select Job Preview.
The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.
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3. In the Tabs area, set the tab attributes.

4. (Optional) In the Text area, set the attributes of the text on the
tabs.

5. Click the Content tab.

6. In the Before Page column, click the first cell and type the
number of the page that you want the tab to precede.

7. In the Text column, type the text for the tab.
The tab appears in the thumbnail area.
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8. To add more tabs, repeat steps 6 and 7.

9. Click Apply to apply the tab settings to your document.
The Tabs Printing window closes, and the tabs that you added
become part of the document.

10. From the Acrobat File menu, select Save, and then close
Acrobat.

Next:

In the job parameters window, under Print > Paper Stock select
the Parameters from file option to print your document.

See also:
Printing a file with mixed paper sizes on page 78

Working with the Creo Server Tabs plug-in for Acrobat 87



Managing tabs

Changing the location of a tab

1. In the Storage area, right-click your unprocessed job, and
select Job Preview.
The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.

4. In the thumbnail area, click the tab that you want to move, and
drag it to the desired location.
The tab moves to the selected location and the tab numbers
are updated accordingly.

Replacing a page with a tab

1. In the Storage area, right-click your unprocessed job, and
select Job Preview.
The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.

4. In the thumbnail area, right-click the page that you want to
replace, and select Replace with tab page.

5. In the table, type the tab text.

The page is deleted from the document, and replaced with a tab
page.

Inserting a tab before or after a specific page

1. In the Storage area, right-click your unprocessed job, and
select Job Preview.
The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.

4. In the thumbnail area, right-click the page and select Insert
tab before page or Insert tab after page.
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Removing a page or tab from the file

1. In the Storage area, right-click your unprocessed job, and
select Job Preview.
The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.

4. In the thumbnail area, right-click the page or tab that you want
to remove, and select Remove.

Saving the tab settings
Requirements:

You have created tabs in a PDF or PostScript file.

After creating tabs in your file, you can save the tab text attribute
settings and the tab locations and captions (text on the tab).

1. In the upper part of the Tabs Printing window, click Save.

2. In the Setting Name box, type a name for the tab settings.

3. Select the Include Tab location and Caption check box to
save the locations and text of the tabs that you created.

4. Click Save.

The setting is saved in the Saved Settings list.

Note: To apply this saved setting to your file, select it from the Saved
Settings list, and then click Apply.
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Deleting saved tab settings

1. In the Storage area, right-click your unprocessed job, and
select Job Preview.
The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. From the Saved Settings list, select the desired saved
settings.

4. Click Delete.

Working with near-line finishers

Near-line finisher overview
The IC-309m print controller supports three near-line finishers—
the Duplo DC-645 slitter/cutter/creaser, Duplo DSF-2000 sheet
feeder, and Duplo DSF-5000 sheet feeder. Using the IC-309m
print controller, you can perform the following actions:

● Generate and print bar codes and registration marks for the
Duplo DC-645 finisher. Bar codes and registration marks are
generated according to the job details programmed on the
finisher.

● Generate and print bar codes, corner marks, and end marks for
the DSF-2000 finisher. Bar codes, corner marks, and end
marks are printed on every page and are automatically created
based on the following job settings:

○ Number of sets

○ Sheet ID

○ Number of sheets in one set

● Generate and print bar codes and end marks for the DSF-5000
finisher. Bar codes and end marks are printed on every page
and are automatically created based on the following job
settings:

○ Number of sets

○ Sheet ID

○ Number of sheets in one set
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Generating a corner mark and bar code
Generate a bar code, or corner mark, and print the finishing marks
for a near-line finisher.

Requirements:

The job details that you are going to use must already be
programmed on the near-line finisher.

1. Open the job parameters window for the desired job.

2. On the Finishing tab, select Near-line finisher.

3. In the Device list, select the finisher that you want to use—for
example, Duplo DSF-2000.

Note: The options that appear vary according to the selected finisher.

4. To print a corner mark, select the Generate corner mark
check box.

5. To print a bar code, select the Generate barcode check box.

6. In the Position list, select the area on the page where you
want to place the corner mark and bar code.

7. In the Side list, select the side of the sheet where you want to
place the corner mark and bar code.

8. To adjust the offset of the corner mark, in the Corner mark
offset boxes, enter values for the horizontal offset and the
vertical offset.

9. To adjust the offset of the bar code, in the Barcode offset
boxes, enter values for the horizontal offset and the vertical
offset.

10. To print an end mark, perform the following actions:

a. Select the End mark check box.

b. In the Side list, select the side of the sheet where you want
to place the end mark.

c. In the Position list, select the area on the page where you
want to place the end mark.

d. To offset the end mark from the center, in the Offset from
center box, enter the value.

e. In the Mark width box, enter the thickness of the end mark.

11. Click Save, and then submit your job for printing.
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Next:

After your job finishes printing, place the pages in the near-line
finisher.

Working in IPDS mode

IPDS overview
Note: The IPDS workflow is available only with the Trans Pack.

The Intelligent Printer Data Stream (IPDS) and the advanced
function printing (AFP) format were developed to support the
printing of transactional jobs with a high level of security.

In the IPDS workflow, two-way communication enables the IPDS
host to send data chunks to the printer and receive information
back from the printer. To maintain data security, data sent by the
host is deleted immediately after being printed.

IPDS printing requires jobs in the AFP file format. AFP is a VDP
format that enables databases, text, and graphic elements to be
merged and displayed on the printed sheet.

There are specific IPDS printers installed to support this workflow.
These IPDS printers can also be customized according to your
needs.

In IPDS printing the IC-309m print controller emulates an IPDS
printer with additional IC-309m print controller capabilities, such as
advanced color and quality features. The IPDS printing is
controlled by the IPDS host and some features on the workspace
and job parameters are changed or unavailable.

Some of those features are:

● The Storage area is unavailable. Only the queues are visible
while in IPDS mode.

● All right-click menu options in the workspace are unavailable,
except for Job Info.

● There is no queue control because there are no pause or
resume buttons.

● The queues are for display only. Management actions, such as
promote jobs, demote jobs, dragging files across queues and
holding/resuming the queues, are unavailable.

● Commercial jobs cannot be processed. Jobs that are sent to
the IC-309m print controller, while in IPDS mode, will be held in
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freeze status in the Incoming queue, until switching back to File
Submission mode.

● The Import button and also most of the IC-309m print
controller's tools such as calibration, job preview, gradation and
more are unavailable. Some stay accessible, for example—the
resource center, spot colors editor and job alerts.

Selecting the IPDS workflow mode
Note: The IPDS workflow is available only with the Trans Pack.

1. In the IC-309m print controller workspace, select File >
Preferences.

2. Select Workflow Mode, and then select IPDS.

3. Click Apply.
Your system is now ready to process and print files using the
IPDS workflow.

Enabling end of job timeout
Note: The IPDS workflow is available only with the Trans Pack.

Use this setting when the last pages of a job are not printed, and
the job remains in the Incoming Queue.

1. In the IC-309m print controller workspace, select File >
Preferences.

2. Select IPDS Settings, and then select Enable end of Job
timeout.

3. Click Save.

Note: If the IPDS host does not send a Define Group Boundary, this
option sets the time out to close the job on the Creo server.

Creating and editing an IPDS printer
Note: The IPDS workflow is available only with the Trans Pack.

1. From the Tools menu, select Resource Center.

2. From the Resource list, select IPDS Printers.

3. Click the New button to add a new printer, or the Edit button
to edit an existing printer.

Note: To edit an existing printer, select the required printer and then
click the Edit button.
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4. In the Name box, type a name for the new printer that you
want to add.

Note: You cannot change the name of the predefined IPDS printers.

5. From the Based on list, select an existing printer with similar
settings.

Note: This parameter cannot be changed for an existing IPDS printer.

6. Click Edit to change the job parameters of your new printer.

Note: If you don't need to edit the job parameters, the settings of the
new printer are taken from the printer on which it is based.

7. In Configuration > IPDS tray mapping, set the Input tray ID
number to the target printer input tray designated for the
selected job printing.

8. Click OK.
The new printer appears in the IPDS printers list.

9. To activate the IPDS printer, select the IPDS printer and then
click Activate.

Setting up the IPDS host
To print IPDS data to the IC-309m print controller you first need to
set up the IPDS host.

Requirements:
Note: The IPDS workflow is available only with the Trans Pack.

This procedure is performed on the IPDS host computer.

1. Create a Print Services Facility (PSF) TCP/IP printer.
This printer will be used as the IC-309m print controller IPDS
printer.

2. Set the following options for the PSF TCP/IP printer:

a. Enter the IC-309m print controller IP address.

b. Enter 5001 for the TCP/IP IPDS port of the IC-309m print
controller.

IPDS printer parameters
Note: The IPDS workflow is available only with the Trans Pack.

You can create new IPDS printers based on the two default
printers for customizing your workflow. For each IPDS printer you
can set the following parameters:

● Configuration

● Print
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● Quality

● Monochrome

See also:
Configuration parameters on page 95
Print parameters on page 97
Quality parameters on page 99
Monochrome parameters on page 100

Configuration parameters
Note: The IPDS workflow is available only with the Trans Pack.

Parameter Option Description

Setup Setup Provides the following options:

● Emulation—This option defines the characteristics of
the IPDS printer emulated by the IC-309m print
controller. When the host inquires to determine which
IPDS printer is connected, the IC-309m print controller
reports this value to the host in a device reply. Certain
emulations are used for more than one printer. The
default option is 4322. This is used for the majority of
emulations, including that of the IBM 4400 Thermal
Printer as well as all other IBM Infoprint printers not
listed explicitly in this option. The IPDS Resolution can
be set to 240, 300, 480, or 600 dpi for the 4322
emulation.

Note: For many of the emulations, the resolution is
limited by the printer, and the IPDS Resolution is
ignored.

● IPDS Resolution—This option specifies the press
supported resolution. You can select: Auto, 240, 300,
480, or 600.

● Valid printing area—Select Border, Move, Edge, or,
Fit

● Report to host on—To control the exceptions and
intervention reporting, select from the following options:

○ VPA Exception

○ Undefined character exception

○ Intervention required

IPDS data traces Enables you to Save IPDS traces.

General Defaults Default code page The selected code page is used as the default character
encoding for the job, unless the IPDS stream already
contains a code page.
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Parameter Option Description

Default font The selected font is used as the default font for the job,
unless the IPDS stream already contains the fonts.

Default font size Enables you to set the default font size for the default font.

Font substitution Provides the following options:

● Relaxed—The IPDS host reports few exceptions

● Strict—The IPDS host reports when a font combination
that is requested by the IC-309m print controller is
invalid.

IPDS trays
mapping

IPDS trays
mapping

Provides the following options:

● Input tray ID

● Output tray ID

Resource capture Resource capture Provides the following options:

● Capture fonts

● Capture data objects

Layout Cut sheet
emulation

Provides the following options:

● Use cut sheet emulation, provides the following
options:

○ Auto (According to host)—Settings are
automatically taken from the IPDS host.

○ On—The cut sheet option is always turned on
regardless of the settings on the IPDS host.

○ Off—The cut sheet emulation is turned off regardless
of the settings on the IPDS host.

● Emulation method—Determines the direction and
rotation of each sheet.

Note: This is applicable whether you have selected cut
sheet emulation on the IC-309m print controller or if the
IPDS host initiates the cut sheet emulation.

● Partition offset X/Y—Determines the partition offset on
each axis, X and Y.

Banner page
handling

Enables you to specify that the job contains a banner page.
If the job is defined to print with a banner page (first
information sheet) then the banner page is printed on a
separate sheet. The banner page does not affect the page
order of the job.

Rotate 180 Enables you to specify the rotation of the image on the
printed sheet. You can apply 180 degrees rotation
independently to both the front and back sides.
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Parameter Option Description

BCOCA
adjustments

1D BCOCA
(barcode)
adjustments

Provides the following options:

● Bar reduction—Enables you to select the reduction
value. You can enter positive numbers from 1 -10.

● Space reduction—Enables you to select the reduction
value. You can enter positive numbers from 1 -10.

2D BCOCA
(barcode)
adjustment

Element reduction—Enables you to select the reduction
value. You can enter positive numbers from 1 -10.

PDF overlay Path for PDF
overlay

Provides the following options:

● Front PDF overlay—Enables you to locate a PDF file
that will be used to overlay the front page.

● Back PDF overlay—Enables you to locate a PDF file
that will be used to overlay the back page.

Note: For wide configuration presses, you can print 2-up
and N-up. The PDF overlay is applied per page, and must
be designed in the page size. For 2-up, the PDF overlay is
placed twice on the sheet.

Advanced Settings Render IO
overlays before
page content

Selecting this option enables the overlays included in the
Include Object (IO) command to be rendered prior to other
elements on the page, thus ensuring the expected print
results.

Print white IOCA
image as

Provides the following options:

● Opaque—Any elements that are under the white IOCA
image will not be visible.

● Transparent—Any elements that are under the white
IOCA image will be visible.

● Transparent only on back—Only on back side any
elements that are under the white IOCA image will be
visible.

● Transparent only on front—Only on front side any
elements that are under the white IOCA image will be
visible.

Support font
modification

Font modification parameters alter the appearance of a
typeface. By default, the following font modification
parameters are defined: double high, italics, double strike,
bold and double wide.

If this option is not selected, font modification does not take
place

Print parameters
Note: The IPDS workflow is available only with the Trans Pack.
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Parameter Option Description

Marks and
barcodes

Marks and
barcodes

Enables you to add a mark set that was defined in the
Resource Center, and define on which sheets the marks
appear.

Provides the following options:

● All—Prints the marks on each sheet in your job

● Repetition—Prints the marks according to the
frequency that you define—for example, if you set the
repetition to 3, the marks will be printed every third
sheet

● Sheet Range—Prints the marks according to the sheet
range that you defined. Provides the following options:

○ Type a range of sheets with a hyphen between the
starting and ending numbers in the range—for
example, 1-5

○ Type a range of sheets with a hyphen or comma
between the starting and ending numbers, and
where the last sheet=n

● 1,n (first and last sheets)

● n–1 (the sheet before last)

● n-<integer> (the integer stands for the number
of sheets before the last sheet)

Note: The sheet range option is applicable to
finishing marks, registration marks and barcodes.

To find out how to define marks and barcodes, see the
section on using mark sets.

Image alignment Image alignment Position of the image relative to the defined printable area:

● Left—Printed image is aligned to the top left side of the
printable area

● Right—Printed image is aligned to the top right side of
the printable area

● Center—Image is placed in the center of the printable
area

Custom offset Enables you to place the image according to the custom x
and y values that you type.

Front - X(Width), Y(Length)

Back - X(Width), Y(Length)

Align back with
front

Enables you to apply the front settings to both the front and
back.

Delivery Face up Delivers the job face up
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Parameter Option Description

Face down Delivers the job face down

Quality parameters
Note: The IPDS workflow is available only with the Trans Pack.

Parameter Option Description

Quality Image quality Provides the following options:

● Normal—Processes the image in the job
according to the standard resolution of the printer.

● High—Improves the quality of low resolution
images in a job.

Image quality is the ability to maintain the same
detail and smoothness at different degrees of
enlargement. The Image quality option is especially
useful when your PostScript file includes several
images of differing quality—for example, images
scanned at different resolutions, rotated, or
downloaded from the Internet.

Image compression
quality

Enables you to control the quality of JPEG images in
your job. Provides the following options:

● Normal

● High

Improve text/line in
Image

Significantly improves the text and line quality in your
job. In some cases, images in the PDL file contain
data that belong to the text and graphics layer, such
as screen captures and high resolution rasterized
text. The IC-309m print controller is able to identify
such images and convert them into text and
graphics.

Select from the following options:

● Auto

● On

● Off

Smooth gradients Blends artificial (or synthetic) vignettes and gradients
in natural images.

Transparency flattening
quality

Improves the quality of transparencies that are
flattened in PDF files.

Overprint Black overprint (apply to
Object Containers)

Ensures that black text prints cleanly within a tint or
picture area. The text appears in a richer, deeper
black, with the underlying CMY values equal to those
of the printed background.
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Parameter Option Description

Resolution Resolution Enables you to set the resolution for the job when
printed. Select either 600 dpi (fine) or 1200 dpi (very
fine).

Screening Screening Method Converts images, graphics and text into information
that can be printed (halftone dots). The human eye
“smooths out” this information, which seems visually
consistent with the original picture. Thus, the more
lines per inch, the more natural the image appears.
Screening is achieved by printing dots in numerous
shapes or lines in an evenly spaced pattern. The
distance between the screen dots or lines determines
the quality of the image. Printers can work with
constant amounts of toner and still produce a wide
range of colors when you use screening. The darker
the color, the larger the dot.

To print an image on a digital printer or press, the
Creo server needs to digitally approximate the
grayscale values with different distributions of pixels.
This process is commonly referred to as halftoning.
Digital halftoning begins by sampling the original
image at the same number of dots per inch as the
printer and constructing digital halftone cells.

Monochrome parameters
Parameter Option Description

CMOCA settings CMOCA Policy Enables you to Override CMOCA settings that are
contained in the file.

CMOCA defaults Enables you to adjust the AFP color settings.
Provides the following options:

● Use tone transfer curve settings

● Use ICC profiles embedded in objects
container data

In case Audit profiles is equal to instruction
profile:

● Use direct path

● Perform Color Management

Profile CMYK source profile Enables you to select a CMYK source profile.

100 Chapter 7—Production workflows



Parameter Option Description

CMYK rendering intent All printers, monitors, and scanners have a gamut or
range of colors that they can output (or view in the
case of a scanner). If a color needs to be output and
is outside the gamut of the output device, it must be
mapped or approximated to some other color that
exists within the gamut. Rendering intent
compresses out-of-gamut colors into the color
capability of the printer you are using. When working
with ICC profiles, it is important that you select the
rendering intent that best preserves the important
aspects of the image. Each rendering method
specifies a CRD for color conversions.

Provides the following options:

● Auto—Select this option when your file includes
different objects on the same page—for example,
a presentation that includes JPEG pictures, text,
and Excel graphs. A different rendering intent is
automatically applied to each type of object
(image, text, and graphic). If RGB images and
CMYK graphic elements are on the same page,
the RGB images will use the perceptual rendering
intent, while the CMYK graphic elements will use
the relative rendering intent.

Note: Preserve pure CMY colors is not affected
by this rendering intent option.

● Relative—This is the default option for CMYK.
This rendering intent maps some closely related
colors in the input color space to the closest
possible color in the output color space. This
mapping reduces the number of colors in the
image.

● Absolute—Select this method for representing
"signature" colors (colors that are strongly
identified with a commercial product). Colors that
fall inside the output color space are represented
very accurately.

● Saturation—Select this method for artwork and
graphs in presentations. In many cases, this
option can be used for mixed pages that contain
both presentation graphics and photographs.

Note: Select Saturation to achieve smoothness
when you print RGB vector graphics (non image
graphics).

● Perceptual—This is the default option for RGB.
Select this method when working with realistic
images such as photographs, including scans and
images from stock photography CDs. All or most
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Parameter Option Description
colors in the original images are changed, but the
relationship between the colors does not change.

RGB source profile Enables you to select an RGB source profile.

RGB rendering intent Provides the following options (for information on
each option, see the descriptions of the CMYK
rendering intent options in this table):

● Auto

● Relative

● Absolute

● Saturation

● Perceptual

Adjustments Brightness Controls the brightness level for the job. The options
range from Lightest, which makes the job 15%
lighter to Darkest, which makes the job 15% darker.

Brightness is generally used to make last-minute
adjustments to the job after proofing. By changing
the Brightness setting, you can control how light or
dark your output appears.

Contrast Controls the difference between the light tones and
the dark tones in your image. The options range from
Less, which makes the job 10% lighter to More,
which makes the job 10% darker. Contrast is
generally used to make last-minute adjustments to
the job after proofing. By adjusting the Contrast
setting, you can control the difference between the
light tones and the dark tones in your image.

Gradation Provides the following predefined option:

● None—The printer applies maximum dry ink
coverage. This is the default setting.

The Gradation parameter also includes a list of the
gradation tables created in the IC-309m print
controller Gradation Tool window. Each gradation
table contains specific settings for brightness and
contrast.

When you select your predefined gradation table,
your job is adjusted according to the specific table's
settings.
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Parameter Option Description

Spot color Spot color Provides the following options:

● Spot library—Applies the CMYK values that are
defined in the spot color dictionaries. You can edit
these values using the Spot Color Editor tool. The
supported spot color dictionaries are: HKS, DIC
Color Guide, Pantone, Pantone GOE, Pantone
Plus, and TOYO. Refer to the Spot Color Editor
window for the complete list.

● Original CMYK file values—Uses the CMYK
values from your file.

Use legacy spot library—Uses the Pantone color
library to print a file that includes a spot color instead
of the Pantone Plus color library. Select from:

● Use PANTONE Plus library

● Use legacy PANTONE library

Highlight colors Enables you to select the IPDS highlight color based
on either the IPDS color mapping table or from the
Spot library (highlight).

Indexed CMR color Enables you to select the indexed CMR colors based
on the CMR color mapping table or from the Spot
library (indexed).

OCA colors CMYK color equivalents for IPDS OCA colors can be
decided from the following options:

● Spot library

● IPDS RGB equivalent

● IPDS CMT or spot library

● IPDS CMT or IPDS RGB equivalent

Protect CMYK
Note: If you protect RGB, gray, or CMYK colors, all
colors in the job that include the same color
combination as the protected color will also be
protected.

Provides the following options:

● Preserve black color—Preserves pure black
during transformation.

● Use protected CMYK values—Retains CMYK
colors as defined in the Spot Color Editor.

RGB Use protected RGB values—Retains RGB colors as
defined in the Spot Color Editor .

Device gray Use protect gray values—Retains gray colors as
defined in the Spot Color editor.
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Working with Job Definition Format

About Job Definition Format
Printing is a manufacturing process that involves countless steps
and people, multilevel dependencies between processes, and
various resource types and tools. It entails the transfer of
information between multiple entities, obtaining approvals, and
delivering final work products. Job Definition Format (JDF) is the
bridge that helps to automate these processes and enable printing
companies to deliver a quality final product on time.

JDF works in tandem with a counterpart format known as the Job
Messaging Format (JMF). JMF provides the means for production
components of a JDF workflow to communicate with system
controllers and administrative components. It relays information
about the progress of JDF jobs and gives management
information systems the active ability to query devices about the
status of processes being executed or getting ready to be
executed

The IC-309m print controller consumes and executes JDF jobs in
which the JDF includes job ticket parameters such as contact
information, number of copies, and media information. The
IC-309m print controller is capable of writing and returning JDF
information after job completion, upon specific requests in the JDF
file (Target Route). Job costing can be calculated from this
information. In addition, the IC-309m print controller supports JMF
when JDF jobs request it specifically (Audit Pool). It sends a JMF
signal each time the status of the JDF job changes, a mechanism
that is useful for job tracking.

Submitting pages from Prinergy using basic JDF instructions
1. In Kodak Prinergy Workshop, in the Job Manager window,

select one or more files in the Input Files area.

Note: You can also insert refined pages.

2. Select a Loose Page Output process plan and, depending on
your workflow requirements, set the output format to either
Vector PDF or Raster PDF.

3. In the Loose Page Output window, select Include JDF for
Digital Print.

4. Select your device, and then select job settings that you want
to apply, for example, the number of copies and media type.

5. Click Browse next to the PDF path box, and locate the
jobuploads folder on the IC-309m print controller.
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6. Click Browse next to the JDF path box, and locate the path to
the hot folder on the IC-309m print controller.
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8 Variable data printing
jobs

Variable data printing jobs
Variable data printing (VDP) is a form of on-demand digital printing
that produces customized or personalized documents targeted to a
specific individual. Within a single document design, elements such
as text, graphics, and images differ from one printed page to the
next based on recipient information garnered from a database.
These documents can include bills, targeted advertising, and direct
mailings.

A VDP job is composed of booklets, which are personalized copies
of a document. Each page in a booklet is constructed as a
collection of individually RIPed elements that can differ from
booklet to booklet, including text, graphics, images, and page
backgrounds. These elements are self-contained graphical entities
that can be line art, text, RIPed images, or a combination thereof.
There are two types of elements in VDP jobs:

● Unique elements, which are used only once for a specific
individual or purpose. An individual's name is an example of a
unique element.

● Reusable VDP elements, which can be used more than once in
different pages, booklets, or jobs. A company logo is an
example of a reusable element.

VDP document formats
The IC-309m print controller can process VDP jobs that are in one
of the following file formats:

● Variable Print Specification (VPS)
● Personalized Print Markup Language (PPML)
● PDF/VT
● Variable Data Exchange (VDX)

Variable data printing (VDP) jobs are created using VDP authoring
programs that support Variable Print Specification formats. Most
VDP authoring programs can convert VDP files to conventional
PostScript files, which can also be processed by the IC-309m print



controller although less efficiently than Variable Print Specification
files. Each authoring program creates VDP code that instructs the
RIP where to place the VDP elements, and each authoring
program does so in a slightly different manner.

The format you choose can be a stand-alone format that covers all
aspects of document design, data management, and text capture,
or it can be an extension of an existing program that enables you
to create VDP documents and VDP jobs.

Variable Print Specification
The Variable Print Specification (VPS) file format was developed
by Creo. It is an extension of the PostScript language. The file
format is comprehensive and can cover a complete range of VDP
documents.

A Variable Print Specification job consists of the following
components:
● Booklet—A personalized copy of a document within a single

print run. Pages or elements within a page can vary from
booklet to booklet.

● Reusable elements—Self-contained graphical entities that can
be line art, text, raster images, or a combination of these types.
Reusable elements are represented in PostScript and can be
stored as EPS files when appropriate. Reusable elements
include clipping and scaling instructions as well as the image
data.

● Inline elements—Unique information that is drawn from a
database and is embedded in the sub-job. This data prints only
once for individual booklets.

PPML
Personalized Print Markup Language (PPML) is an XML-based
print language developed by some of the world's leading
manufacturers of print technology for the high-speed reproduction
of reusable page content. It is an open, interoperable, device-
independent standard that makes use of personalized print
applications. Various vendors have created software that can
generate PPML files.

The IC-309m print controller supports PPML formats and enables
you to process PPML jobs efficiently and import jobs in various
VDP formats to the IC-309m print controller.

PPML has a hierarchical structure. Document components are
separated from their submission file and can be organized and
stored at different levels of the hierarchical structure.
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About PDF/VT file formats
The PDF/VT file format is designed to enable variable document
printing (VDP) in a variety of environments. PDF/VT documents
contain the final content elements and associated metadata, but
not any variables or templates. The predecessor standard ISO
16612-1:2005 specified the PPML/VDX formats based on PDF
1.4. However, this older standard was missing several PDF
features and relied on constructs external to PDF. The modern
standard PDF/VT is based on the PDF/X-4 and PDF/X-5
standards and supports PDF 1.6 features including transparency,
layers, and ICC-based color management. In addition to the
requirements of PDF/X, the PDF/VT standard adds supplementary
features to PDF to meet the requirements of high-volume
personalized printing. PDF/VT enables high-performance
rendering (RIPing) of digital print files by adding efficient resource
management to PDF.

As PDF/X includes color management features and support for
ICC color profiles, PDF/VT inherits the same features.

The IC-309m print controller supports the following PDF/VT file
formats:

● PDF/VT1

● PDF/VT2

○ PDF/X4

○ PDF/X4p

○ PDF/X4pg

○ PDF/X5g

Deleting reusable elements
Variable data printing (VDP) elements that are no longer in use
take up valuable disk space on the IC-309m print controller. To
free up disk space, you can delete the reusable elements that you
no longer need.

The IC-309m print controller caches reusable elements per job,
and displays a list of the cached elements in the Reusable
Elements management area in the Resource Center. Reusable
elements are cached as PDL elements.

Note: The Reusable Elements Management tool is only available with the
Action Pack.
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1. From the Tools menu, select Resource Center.

2. In the Resource list, select Reusable Elements
management.
Your VDP jobs are listed in the left pane. In the right pane, all
of the reusable elements that are associated with your job are
listed.

3. Select the elements that you want to delete, and then click
Delete.
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9 Job parameters

Print tab in the job parameters window
Edit print parameters for your job.

Parameter Option Description

Paper stock Paper stock Provides the following options:

● Parameters from file—Maps the paper parameters according to
one of the following options:

○ Paper name available in the trays

○ Auto rule set

○ Custom rule set

Clicking File mapping displays the mapping results and enables
you to edit the parameters.

● Paper name—The available paper names listed in the paper
name library. Clicking .... enables you to select a predefined
paper name from the Resource Center window and check that the
paper name is loaded in the printer

○ Paper size—The available paper sizes

Note: If the selected paper stock and size are not loaded in
one of the connected trays, the current job is held until the
appropriate set is available. The job receives an on hold
status indicator, and a message appears in the Message
Viewer window. Other jobs can be printed while jobs are held..

○ Media Type—The media type that you want to use. When the
default setting, Use Printer settings is selected, your job is
printed on the media type that is defined on the printer.

○ Weight—The media weight that you want to use. When the
default setting, Use Printer Settings is selected, your job is
printed on the paper weight that is defined on the printer.

○ Color—Enables you to print your job on colored paper.

○ Punched—Enables you to print your job on pre-punched
paper.

● Tray—The specific paper stock that you want to use is loaded in
this tray

Tab kick-out Kick out unused tabs—Enables you to select the sub-tray in which
to send unused tabs



Parameter Option Description

Copies and
pages

Number of
copies

The number of copies that you want to print.

Note: For step-and-repeat imposed jobs, the number of copies is
defined according to pages or sheets.

Print range The print range that you want to print:

● All

● Front side

● Back side

● Pages

You can select specific pages, booklets, or page ranges and can
specify the pages or booklets to be printed as follows:

● By typing one or several numbers separated by commas and no
spaces—for example, 1,3,5.

● Type a range of pages or booklets with a hyphen between the
starting and ending numbers in the range—for example, 1-5, or
1-3,5.

Note: For imposed jobs, pages changes to sheets.

Print method Print method Provides the following options:

● Simplex—Single-sided printing

● Duplex head to head—Two-sided printing for book-style hard
copies (usually used with portrait jobs).

● Duplex head to toe—Two-sided printing for calendar-style hard
copies (usually used with landscape jobs).

Layout Scaling Provides the following options:

● Manual—Increases or decreases the image size according to the
percentage that you enter.

Note: The default option, 100%, prints the original image size.
Scaling is not applied.

○ Do not affect imposition marks—Scales the page without
changing the location of the imposition marks

● Fit to output sheet size—Fits the image to the selected paper
size.

Note: You can also use the Fit to output sheet size option to
scale the layout for imposed jobs.
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Rotate 180º Rotates your job by 180°. Provides the following options:

● All pages

● All front pages

● All back pages

● All landscape pages

● All portrait pages

Image
alignment

Image
alignment

Position of the image on the sheet:

● Left—Printed image is aligned to the top left side of the sheet

● Right—Printed image is aligned to the top right side of the sheet

● Center—Image is placed in the center of the sheet

Custom offset Enables you to place the image according to the custom x and y
values that you type.

Front - X(Width), Y(Length)

Back - X(Width), Y(Length)

Align back
with front

Enables you to apply the front settings to both the front and back.
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Imposition tab in the job parameters window
Set and apply imposition settings to your job.

Parameter Option Description

Imposition
method

Method Provides the following options:

● None—Imposition parameters are not available, and the
thumbnail viewer does not display an image. This is the default
option.

● Step & Repeat—A technique in which multiple copies of an
image are printed to fill up a large sheet. This method is used
mainly for business cards.

Note: The number of copies is defined according to pages or
sheets.

● Step & Continue—A technique in which different pages of a job
are printed on one sheet according to the selected layout, so that
the sheet is filled to capacity.

● Cut & Stack—A book-finishing technique in which jobs are
printed, cut, stacked, and bound in the most efficient manner to
preserve the original sorting. A job's pages, booklets, or books
are sorted in a Z-shape, (each stack of pages is sorted in
consecutive order). When stacks are piled one on top of another,
the entire job is already sorted up or down.

○ Stack size— Enables you to define the number of sheets to
place in the printer's stacker tray, according to the limitation of
the finisher present on the site.

Note: The Stack size parameter splits the job into several
logical parts. When requesting multiple copies for such jobs,
each logical part of the job is printed according to the
requested number of times, instead of the entire job
completely.

● Saddle Stitch—A book-finishing technique in which the pages of
a book are attached through stitching or stapling in the spine fold
—for example, in brochures.

○ Sets per sheet—Enables you to select the number of sets of
the job to print on the defined printable area.

○ Stacking mode for VDP—For VDP jobs only. This option
enables you to print two or more different booklets on the
same sheet. The booklets are arranged in the Cut & Stack
method.

● Perfect Bound—A book-finishing technique in which the spine
fold is trimmed and the edges of the gathered pages are
roughened and glued together—for example, in hardcover books.

○ Sets per sheet—Enables you to select the number of sets of
the job to print on the defined printable area.

○ Stacking mode for VDP—For VDP jobs only. This option
enables you to print two or more different booklets on the

114 Chapter 9—Job parameters



Parameter Option Description
same sheet. The booklets are arranged in the cut-and-stack
method.

○ Nested Saddle - Sheet per group—A book-finishing
technique that combines the saddle-stitch imposition method
and the perfect bound imposition method. As with saddle
stitching, pages are grouped together and stapled or stitched
across a common center fold. The saddle groups are then
stacked one on top of another and glued, as with perfect
binding.

● Folded Signature—A technique in which a large sheet is folded
several times to form a section of a book, a magazine, or a
pamphlet.

Preview Enables you to view either a thumbnail view or a layout view of your
imposition layout and settings. You can open the Preview window at
any time and keep it open to check your imposition settings as you
select them. The Preview window dynamically reflects any changes
that you make.

Size Trim size The size of the finished, trimmed document. For custom trim sizes,
you must specify a width and height.

Tip: If you set the trim size smaller than the page size set in the DTP
application, the data will be cropped. Setting a larger trim size results
in a larger border on the printed page.

Trim
orientation

Displays the orientation, portrait or landscape, for the selected trim
size. If the wrong orientation is selected, the job might be cropped as
a result.

Preview Enables you to view either a thumbnail view or a layout view of your
imposition layout and settings. You can open the Preview window at
any time and keep it open to check your imposition settings as you
select them. The Preview window dynamically reflects any changes
that you make.

Templates Layout Provides the following options:

● Custom—Enables you to specify how many pages to place
horizontally (Rows) and vertically (Columns) in a custom layout.

Note: Templates that are created or imported via the Imposition
Template Builder are also available.

● Best Fit—Automatically calculates the most suitable number of
columns and rows.

Note: This option is not available for the saddle-stitch and perfect
bound imposition methods.
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Print method Provides the following options for how the document will be printed:

● Simplex

Note: This option is not available for the saddle-stitch and perfect
bound imposition methods.

● Duplex HTH

● Duplex HTT

Binding
selection Note: This option is available only if the imposition method is either

Saddle stitch or Perfect bound and the template is 2 x 1, 2 x 2, 4 x
2, or 4 x 4.

North south Places pages 180 degrees from each other, on the same side of the
imposed sheet. Use this option when a step-and-repeat 2 x 1 or 1 x 2
template is selected.

Rotate 90 deg Rotates the entire template 90 degrees to the right, enabling you to
correct imposition conflicts.

Folding
Preview

Enables you to preview the folding steps for the folded signature
predefined templates.
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Marks Marks Provides the following options:

● None—Does not apply any marks on the imposition layout for the
printed job.

● Crop marks—Prints the lines that indicate where the sheet
should be cropped to the trim size.

Notes:

○ If you want to use crop marks that were incorporated in the
DTP application, make sure that enough space is left around
your page in the PostScript file so that the page prints with
crop marks.

○ If your job already includes crop marks incorporated in the
DTP application, you do not need to add crop marks here. If
you do add crop marks, both sets of crop marks can be
printed.

● Fold marks—Prints the lines that indicate where the sheet should
be folded. This option is available only when the imposition
method is set to Saddle stitch or Perfect bound.

● Crop & fold marks—Prints the lines that indicate where the
sheet should be cropped and folded. This option is available only
when the imposition method is set to Saddle stitch or Perfect
bound.

● Both Sides—Prints the marks on both sides of the page.

● Horizontal offset—Enables you to move the horizontal mark up
or down.

● Vertical offset—Enables you to move the vertical mark to the left
or to the right.

● Marks color—Prints the marks in either Black, White or Gray.

● Print hairline where sheet folds—Enables you to print a very
thin black line on the folding lines in your job.

● ?—Provides a visual reference for the spacing and marks
parameters when you click the question mark icon.

Preview—Enables you to view either a thumbnail view or a layout
view of your imposition layout and settings. You can open the
Preview window at any time and keep it open to check your
imposition settings as you select them. The Preview window
dynamically reflects any changes that you make.

Imposition tab in the job parameters window 117



Parameter Option Description

Signature
marks

Mode Enables you to print a mark on the front or back of a folded
signature. Signature marks help in assembling printed signatures for
binding in the correct order.

Provides the following options:

● Off—Signature marks are not selected.

● Auto—Automatically calculates the position and offset of the
mark. Enables you to determine the amount of black toner used
for printing the signature mark.

● Custom—Enables you to define the signature marks for printing
according to height, width, type, and the number of marks.

First Mark
Position Note: This option is available only when the signature mark mode is

set to Custom.

Enables you to specify the position of the first signature mark.

Mark Offset
Note: This option is available only when the signature mark mode is
set to Custom.

Enables you to specify the offset between signature marks.

Black Color Enables you to determine the amount of black toner used for printing
signature marks.

Spacing Margins Determines the space between the edge of the pages and the edge
of the sheet on which the pages are printed.

Notes:

● Margin settings should suit the finishing equipment and
requirements.

● Confirm the binding parameters with your binder when planning
your sheet.

Horizontal
gutter

Determines the horizontal space between pairs of pages (according
to the trim size) on a sheet. When the pages are folded into a
booklet, the gutter allows space for trimming.

The value that you enter depends on the paper size and imposition
method that you choose.

Vertical gutter Determines the vertical space between pairs of pages (according to
the trim size) on a sheet. When the pages are folded into a booklet,
the gutter allows space for trimming.

The value that you enter depends on the paper size and imposition
method that you choose.
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Spine
Note: This option is available only when the imposition method is set
to Perfect Bound.

Determines where the signatures are joined at the center fold and
then stitched or bound.

The value that you enter depends on the paper size that you choose.

Gap Between
Sets Note: This option is available only when the imposition method is set

to Saddle Stitch or Perfect Bound and the Sets per Sheet option is
set to more than 1.

Controls the gap between sets of saddle-stitch booklets placed on
one sheet.

Bleed ● Extends part or all of the printed image beyond the trimming
boundary.

● Ensures that an inaccurate cutting will not leave undesired white
space at the edge of the page.

● Produces sharp page boundaries with color that extends all the
way to the edge of the page.

The value that you enter depends on the paper size and imposition
method that you choose. You can select Maximum bleed or enter a
Custom bleed size.

Notes:

● You cannot extend the bleed beyond the sheet fold lines. Bleed
does not affect the position of a crop.

● Bleed must be defined in your DTP application in order for the
IC-309m print controller to be able to apply bleed options.

? Enables you to view help on spacing and marks.

Preview Enables you to view your imposition layout and settings. You can
open the Preview window at any time and keep it open to check your
imposition settings as you select them. The Preview window
dynamically reflects any changes that you make.
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Creep Creep
Note: Creep is only available when imposition is set to Saddle
stitch, or when the Nested Saddle option is selected for the Perfect
Bound imposition method.

Creep is used to compensate for the physical shift of the inner sheets
of a saddle stitch booklet. Set the size of the page shift from or
towards the spine.

Provides the following options:

● Creep in

○ Auto—Automatically sets a value based on the paper's
weight.

○ Custom—Enables you to set a custom creep in value.

● Creep out—Enables you to set a creep out value (negative or
positive value).

Preview Enables you to view your imposition layout and settings. You can
open the Preview window at any time and keep it open to check your
imposition settings as you select them. The Preview window
dynamically reflects any changes that you make.

See also:
Imposition overview on page 59

Quality tab in the job parameters window
Apply settings to improve the quality of image, graphics, and text
elements in your job.

Parameter Option Description

Quality Image quality Provides the following options:

● Normal—Processes the image in the job according to the
standard resolution of the printer.

● High—Improves the quality of low resolution images in a job.

Image quality is the ability to maintain the same detail and
smoothness at different degrees of enlargement. The Image quality
option is especially useful when your PostScript file includes several
images of differing quality—for example, images scanned at different
resolutions, rotated, or downloaded from the Internet.
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Image
compression
quality

Enables you to control the quality of JPEG images in your job.
Provides the following options:

● Normal

● High

Improve text/
line in Image

Significantly improves the text and line quality in your job. In some
cases, images in the PDL file contain data that belong to the text and
graphics layer, such as screen captures and high resolution
rasterized text. The IC-309m print controller is able to identify such
images and convert them into text and graphics.

Select from the following options:

● Auto

● On

● Off

Smooth
gradient

Blends artificial (or synthetic) vignettes and gradients in natural
images.

Transparency
flattening
quality

Improves the quality of transparencies that are flattened in PDF files.

Overprint Black
overprint

Ensures that black text prints cleanly within a tint or picture area. The
text appears in a richer, deeper black, with the underlying CMY
values equal to those of the printed background.

PostScript
overprint

Uses the overprint information that exists in the PostScript file. This
option also determines whether the DTP application's PostScript
overprint settings are retained in the RIP.

Resolution Resolution Enables you to set the resolution for the job when printed. Select
either 600 dpi (fine) or 1200 dpi (very fine).

Screening Screening
Method

Converts images, graphics and text into information that can be
printed (halftone dots). The human eye “smooths out” this
information, which seems visually consistent with the original picture.
Thus, the more lines per inch, the more natural the image appears.
Screening is achieved by printing dots in numerous shapes or lines
in an evenly spaced pattern. The distance between the screen dots
or lines determines the quality of the image. Printers can work with
constant amounts of toner and still produce a wide range of colors
when you use screening. The darker the color, the larger the dot.

To print an image on a digital printer or press, the Creo server needs
to digitally approximate the grayscale values with different
distributions of pixels. This process is commonly referred to as
halftoning. Digital halftoning begins by sampling the original image at
the same number of dots per inch as the printer and constructing
digital halftone cells.
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Monochrome tab in the job parameters window
Although the IC-309m print controller drives monochrome printers,
you apply various color settings and options to improve the color
quality of your job when the job is processed.

Parameter Option Description

Profile CMYK source
profile

Enables you to select a CMYK source profile.

CMYK
rendering
intent

All printers, monitors, and scanners have a gamut or range of colors
that they can output (or view in the case of a scanner). If a color
needs to be output and is outside the gamut of the output device, it
must be mapped or approximated to some other color that exists
within the gamut. Rendering intent compresses out-of-gamut colors
into the color capability of the printer you are using. When working
with ICC profiles, it is important that you select the rendering intent
that best preserves the important aspects of the image. Each
rendering method specifies a CRD for color conversions.

Provides the following options:

● Auto—Select this option when your file includes different objects
on the same page—for example, a presentation that includes
JPEG pictures, text, and Excel graphs. A different rendering intent
is automatically applied to each type of object (image, text, and
graphic). If RGB images and CMYK graphic elements are on the
same page, the RGB images will use the perceptual rendering
intent, while the CMYK graphic elements will use the relative
rendering intent.

Note: Preserve pure CMY colors is not affected by this
rendering intent option.

● Relative—This is the default option for CMYK. This rendering
intent maps some closely related colors in the input color space to
the closest possible color in the output color space. This mapping
reduces the number of colors in the image.

● Absolute—Select this method for representing "signature" colors
(colors that are strongly identified with a commercial product).
Colors that fall inside the output color space are represented very
accurately.

● Saturation—Select this method for artwork and graphs in
presentations. In many cases, this option can be used for mixed
pages that contain both presentation graphics and photographs.

Note: Select Saturation to achieve smoothness when you print
RGB vector graphics (non image graphics).

● Perceptual—This is the default option for RGB. Select this
method when working with realistic images such as photographs,
including scans and images from stock photography CDs. All or
most colors in the original images are changed, but the
relationship between the colors does not change.
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RGB source
profile

Enables you to select an RGB source profile.

RGB
rendering
intent

Provides the following options (for information on each option, see
the descriptions of the CMYK rendering intent options in this table):

● Auto

● Relative

● Absolute

● Saturation

● Perceptual

Adjustments Brightness Controls the brightness level for the job. The options range from
Lightest, which makes the job 15% lighter, to Darkest, which makes
the job 15% darker.

Brightness is generally used to make last-minute adjustments to the
job after proofing. By changing the Brightness setting, you can
control how light or dark your output appears.

Contrast Controls the difference between the light tones and the dark tones in
your image. The options range from Less, which makes the job 10%
lighter to More, which makes the job 10% darker. Contrast is
generally used to make last-minute adjustments to the job after
proofing. By adjusting the Contrast setting, you can control the
difference between the light tones and the dark tones in your image.

Gradation Contains a list of gradation tables that were created in the IC-309m
print controller Gradation Tool window. Each gradation table contains
specific settings for brightness and contrast.
In addition to the gradation tables created in the IC-309m print
controller, the following default gradation table is available:

● None—Applies maximum dry ink coverage. This is the default
setting.

When you select your predefined gradation table, your job is
adjusted according to the specific table's settings.
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Spot color Spot color Provides the following options:

● Spot library—Applies the CMYK values that are defined in the
spot color dictionaries. You can edit these values using the Spot
Color Editor tool. The spot color dictionaries supported are: HKS,
DIC Color Guide, Pantone, Pantone GOE, Pantone Plus, and
TOYO. See the Spot Color Editor window for the complete list.

● Original CMYK file values—Uses the CMYK values from your
file.

● When using PANTONE spots—Enables you to select which
PANTONE library to use for your PANTONE spots. Provides the
following options:

○ Use PANTONE Plus library

○ Use legacy PANTONE library

Protect colors CMYK
Note: If you protect RGB, gray, or CMYK colors, all colors in the job
that include the same color combination as the protected color, will
also be protected.

Provides the following options:

● Preserve black color—Preserves pure black during
transformation.

● Use protected CMYK values—Retains CMYK colors as defined
in the Spot Color Editor.

RGB Use protected RGB values—Retains RGB colors as defined in the
Spot Color Editor.

Gray Use protected gray values—Retains gray colors as defined in the
Spot Color Editor.

Finishing tab in the job parameters window
Apply these settings to specify how to finish your job.

Parameter Option Description

Finishing Lists the available finisher options. This list depends on the modules
that are installed on the printer.

Stapler sub
tray

Multi hole punch—This option is available only if the multi hole
punch module is connected.
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Stapler Main
tray

● Staples

○ None

○ Rear

○ Front

○ Dual

● Multi hole punch—This option is available only if the multi hole
punch module is connected.

● Offset

Stapler Fold
tray

● Fold type

○ Multi half fold

○ Multi tri-fold-in

Center staples—Staples the center of the booklet
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Multi fold sub
tray

● Fold type

○ Tri-fold-in

○ Tri-fold-out

○ Double parallel fold

○ Gate fold

● Punch—The values vary according to the type of punch unit
connected. The number of holes is 2, 3, or 4.
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Multi fold
main tray

● Fold type

○ Half fold

○ Z fold

○ Tri-fold-in

○ Tri-fold-out

○ Double parallel fold

○ Gate fold
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● Punch—The values vary according to the type of punch unit
connected. The number of holes is 2, 3, or 4.

Multi Tri-fold-
in

Saddle stitch
sub tray

Multi hole punch—This option is available only if the multi hole
punch module is connected.

Saddle stitch
main tray

● Center Staples—Staples the center of the booklet

● Trim

Stacker Sub
Tray

Multi hole punch—This option is available only if the multi hole
punch module is connected.

Stacker Main
Tray

● Multi hole punch—This option is available only if the multi hole
punch module is connected.

● Offset

● Sample print—Enables you to print extra pages to an easily
accessible output tray during a long print job and verify that the
printer is performing as expected. For example, when a job is
currently printing to a closed elevator (such as, 1000 pages to an
output tray that cannot be opened until the entire job is
completed), you can use the sample print function to print a
separate page or finished output set to an open output tray to
verify the output. If the output is unsatisfactory, you can take
corrective action.

Perfect binder
sub tray

Multi hole punch—This option is available only if the multi hole
punch module is connected.
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Perfect binder
main tray

The perfect binder provides the following options:

● Pull Cover from—Enables you to select the tray that contains the
paper on which the cover will be printed

● Cover content

○ Blank/Preprinted—Cover is not printed as part of the job

○ Compose from file (Simplex)— Front and back covers are
part of the file and should be composed and printed on the
outside of the cover sheet

○ Compose from file (Duplex)— Front and back covers are
part of the file and should be composed and printed on the
outside and inside of the cover sheet

○ Print (Simplex)—Front and back covers are included on the
same page in the file and are printed on the outside of the
cover sheet

○ Print (Duplex)—Front and back covers are included on the
same page in the file and are printed on the inside and the
outside of the cover sheet

● Cover orientation—Enables you to select the print orientation of
the cover when cover content is Print (Simplex) or Print
(Duplex)

● Spine

○ Blank—Prints a blank spine

○ From file—Prints the spine content contained on the first
page of the file

● Binding

○ Left

○ Right

○ Top

○ Bottom

Notes: Make sure you follow these actions when you load pre-
printed covers into feed trays:

○ Left Binding—Trays 1, 2, or 3‑‑Load cover face down, top of
cover must point to rear of machine

○ Left Binding—Bypass, Cover tray, PI1, PI2‑‑Load cover face
up, top of cover must point to rear of machine

○ Right Binding—Trays 1, 2, or 3‑‑Load cover face down, top of
cover must point to front of machine

○ Right Binding—Bypass, Cover tray, PI1, PI2‑‑Load cover face
up, top of cover must point to front of machine
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● Trim

● Priority Print

● Clicking Shift Settings enables you to shift the image on your
cover horizontally and vertically.

Print order Collation Collated—Prints a complete copy of the job before the first page of
the next copy is printed.

Delivery Sets the print order from back to front.

● Face up—Delivers the job face up.

● Face down—Delivers the job face down.

Print order Provides the following options:

● 1 to N—Prints a complete copy of the job from the first page to
the last page.

● N to 1—Prints a complete copy of the job from the last page first
in the stack, to the first page, last in the stack.

Near-Line
Finisher

Device Enables you to select one of the near-line finishing devices, Duplo
DC-645, DSF-2000, or DSF-5000.

● Duplo DC-645 finisher cuts, slits, and creases documents using
registration marks and barcodes.

Note: A barcode is used only if you want to use a preset job
number. Otherwise, you can select it manually on the Duplo
DC-645.

● DSF-2000 finisher is a sheet feeder that is configured with a
barcode reader.

● DSF-5000 finisher is a sheet feeder that is configured with a
barcode reader.

Inverter Select Inverter when processing a stack in which the first page is
face down and on the bottom of the stack.

Note: Clear Inverter for a stack whose first page is face up on the
bottom of the stack.

Generate
registration
mark

Select Generate registration mark to print registration marks on
sheets.
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Generate
corner mark

Select Generate corner mark to print correct corner marks on
sheets. The long line is parallel with the lead edge of a sheet and the
short line is perpendicular to the lead edge of a sheet.

The SCC measures distance both horizontally and vertically. Based
on measured distance, SCC manages slit positions, cut positions,
and crease positions. The Reference position is the start point to
measure the Finished size and the Crease position.

Note: When the CCD Scanner is not active, the actual corner of each
sheet is the starting point to measure distance.

Generate
barcode

Select Generate barcode to place the barcode in any corner of the
page with offsets and in front or back side of the sheet. Type the
distance in mm.

Note: The IC-309m print controller allows you to place the
registration mark and barcode in any corner of the page with offsets
(in-track and cross track).

Position Generates a barcode in the following location of the page: Top right,
Top left, Bottom right, and Bottom left.

Side Select the side where the barcode will be generated. Select Front
side or Back side.

Registration
line offset

Paper width direction—the whole registration mark is placed within
3 mm -20 mm from the right edge.

Note: This option is available for the DC-645.

Corner mark
offset

The corner mark is placed in a range of 0 - 25 mm (horizontal and
vertical distance).

Note: This option is available for the DSF-2000.

Barcode
offset

Paper feed direction—The whole barcode should be within 3 mm- 20
mm from lead edge Paper width direction: The whole barcode should
be within 25 mm - 60 mm from the right edge.

End mark The Duplo DSF-2000 includes an end mark detector that can detect
collation and paper feed errors, and prevents binding errors.
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Parameter Option Description

Marks and
barcodes

Enables you to add a mark set that was defined in the Resource
Center, and define on which sheets the marks appear.

Provides the following options:

● All—Prints the marks on each sheet in your job.

● Repetition—Prints the marks according to the frequency that you
define—for example, if you set the repetition to 3, the marks will
be printed every third sheet.

● Sheet Range—Prints the marks according to the sheet range that
you defined. Provides the following options:

○ Type a range of sheets with a hyphen between the starting
and ending numbers in the range—for example, 1-5.

○ Type a range of sheets with a hyphen or comma between the
starting and ending numbers, and where the last sheet=n.

● 1,n (first and last sheets)

● n–1 (the sheet before last)

● n-<integer> (the integer stands for the number of sheets
before the last sheet)

Note: The sheet range option is applicable to finishing marks,
registration marks and barcodes. If Sheet Range is selected
and a range is not entered, the job will not be submitted/
saved.

Slip Sheet Slip sheets
between
copies

Prints slip sheets with your job. If a job is collated, the slip sheets are
printed between sets. If a job is not collated, the slip sheets are
printed between groups.

● Same as job—Uses the same paper stock that is defined for the
job.

● Paper Name—Enables you to select the paper name on which to
print the slip sheet.

○ Paper size—Select the desired paper size.

● Tray—The tray in which the specified paper stock is loaded.

● Frequency—Determines how often to print a slip sheet. after
each copy or after each 6 copies, and so on. The default is set to
1.
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Exceptions tab in the job parameters window
Add and delete page exceptions and inserts

Parameter Option Description

Exceptions
Note: When imposition is enabled, the range is indicated in sheets,
otherwise it is indicated in pages.

Define the type of exception for your job.

● Page range/Sheet range—Type the range of /sheets for the
exception.

● Sets range—Type the range of sets for the exception
programming.

Note: This option is only available for jobs that are split to sets in
the Services tab.

● Front cover or Back cover—Select one of the duplex options to
print the first two (or last two) pages of the job as the cover page
(back cover).

Note: If the imposition type is Saddle Stitch, select Cover to
print both a front and back cover page on a different media type.
Select Middle sheet to print the internal sheet on a different
media type.

● Inserts—Select Before or After and type the page number that
will precede or follow the insert. Then, in the Quantity box, type
the total number of inserts you want to add.

Advanced
options

Enables you to define print options for the page exception that you
are assigning to your job. Provides the following options:

● Range—Enables you to specify the page range.

● Print method—Enables you to specify a different print method.

● Paper stock—Enables you to select a different paper stock and
tray.

● Image alignment—Enables you to shift the position of the image.

● Layout—Enables you to rotate the image 180°.

● Finishing—Enables you to select a different finishing options for
the selected set range.

Note: This option is only available for jobs that are split to sets in
the Services tab.
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Parameter Option Description

Exceptions
from File

Provides the following options:

● Select Rule Set—Enables you to select a rule set, which was
created for a file that includes dynamic page exceptions, and
assign the rule set to your job.

● File mapping —Enables you to verify that the dynamic page
exceptions in your file were mapped correctly to the paper stock
parameters or to the input tray and if necessary edit the mapping
results

See also:
Printing dynamic page exceptions on page 77
Setting custom page exceptions via the job parameters window
on page 79

Services tab in the job parameters window
Set parameters that will facilitate your job workflow. For example,
you can set workflow policies and activate a workflow to decrease
processing time for certain files.

Parameter Option Description

Banner Page Print banner
page

The banner page contains job-related information such as the job
title, sheet size, number of pages or sets, and the sender name.

Provides the following options:

● Same as job—Enables you to print the banner page on the same
paper stock that is being used for printing the job.

● Paper name—Enables you to select a different paper name on
which to print the banner page.

○ Paper size—The available paper sizes.

● Tray—Enables you to select the tray that is loaded with the paper
stock on which to print the banner page.
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Parameter Option Description

Job flow Job flow Defines the flow that the job associated with this job ticket follows
when submitted to the IC-309m print controller

Provides the following options:

● Print—RIPs, prints, and stores the PDL files in the Storage area
(unless the Job Deletion parameter is set to Delete printed jobs
from storage).

● Process—RIPs and moves the PDL files to the Storage area as
RTP jobs.

● Store—Places the PDL files directly into the Storage area
without processing them.

Gallop Enables you to start printing a long job, usually VDP, while the job is
still being spooled and processed.

Native PDF
workflow

Processes PDF files natively using the Adobe PDF Print Engine
(APPE). The APPE RIP ensures that complex designs and effects,
including transparencies, are reproduced quickly and correctly.

Provides the following options:

● Use APPE RIP—Uses the APPE RIP for PDF files. All other file
types are processed using the CPSI RIP.

—This icon appears in the RIP Type column in the IC-309m
print controller workspace and indicates that APPE RIP is used.

Job Deletion Delete printed
jobs from
storage

Removes jobs from the Storage area after printing is completed.

You can select whether to delete the RTP and original file or the
RTP only (keep original file).

Delete failed
jobs from
storage

Removes failed jobs from the Storage area while other jobs are
being processed or printed.

You can select whether to delete the RTP and original file or the
RTP only (keep original file).

Notes:

● The Delete failed jobs from storage option retains enough free
disk space for the duration of the print run and only affects the
sub-job.

● The associated Variable Print Specification file is also deleted.

● If you select Delete failed jobs from storage and RTP and
original file, the RTP data and the PDL file (PostScript, PDF,
EPS, Variable Print Specification, or PPML) is deleted.

Font
substitution

Use default
font / Use font
emulation

Use default font is applied with CPSI RIP. Use font emulation is
applied with APPE RIP.

Optimizations PostScript
optimization

Significantly decreases the processing time for PostScript jobs with
repeated elements by applying a workflow intended for PostScript
jobs.
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Parameter Option Description

PDF
optimization

Significantly the decreases processing time for PDF jobs with
repeated elements by applying a workflow intended for PDF jobs.

Job slug Job name Prints the name of the job in the margin of the sheets.

Sheet number
and side
(front/back)

Prints the sheet number and side (front or back) in the margin of the
sheets.

Date and time Prints the date and time in the margin of the sheets.

ISO
conformance
level

Prints the ISO conformance level in the margin of the sheets—for
example, Validation Print according to ISO 12647-7.

Printer
description

Prints the name and model of the printer in the margin of the sheets.

Creo server
description

Prints the name and model of the server in the margin of the sheets.

Colorant and
media

Prints details about the loaded paper in the margin of the sheets.

Screening Prints the images, graphics and text that has been converted to
halftone dots.

Comment Enables you to add comments containing up to 30 characters.

Preflight Run Preflight Checks the status of the main file only (default), including fonts, high
resolution images, and spot colors, before the job is sent for printing.
If required, you can select to include the external elements in the
check.

Your job is RIPed and the missing components are identified.

● Run extended preflight check— Performs an extended preflight
inspection of the files running in the incoming queue. Clear this
check box if you only want a basic preflight check to be performed
on files running in the incoming queue. A basic preflight check
validates that external elements and AFP resources are missing.

○ Inspect the main file only—Checks the status of the main file
only (default).

○ Inspect also external elements—Includes external elements
in the preflight check, and checks for spot colors and fonts in
those external elements.
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Parameter Option Description

Split to sets Split to sets Splits static jobs, such as PostScript, PDF, or large VDP jobs that do
not have a booklet structure into booklets.

Notes:

● This option is not applicable for VDP jobs that already have a
booklets structure.

● The Split to Sets parameter splits job into several logical parts.
When requesting multiple copies for such jobs, each logical part
of the job is printed according to the requested number of times,
instead of the entire job completely.

Fixed size
sets

Number of pages per set—The desired fixed number of pages per
booklets.

Note: If the specified number of pages per booklet is not sufficient to
produce complete booklets and there is a remainder of pages, the
last pages will form a booklet that contains less pages than specified.

Custom size
sets

The number of pages per booklet that can be of varying sizes. Click
+(Add) to add the desired booklet sizes. Click the Apply button after
defining the booklets. The software calculates the ranges and
defines the remaining booklets (if necessary) to close the job.

APR/OPI Enable APR/
OPI

Select this option to support APR and OPI.

Job info Job title Displays the original name of the file related to this job.

Sender Displays the user name of the system from which this job originated.

Account Displays the account number of a specific customer or group.

Recipient Displays the name of the customer.

Job
comments

Displays special instructions that you want to include in your job.

Job link Displays the relevant URL for the linked elements of a JDF job.

Summary tab in the job parameters window
View all of the information from the job parameters window for a
specific job.

Parameter Option Description

Job summary Provides a summary of the job parameters in a single window.

Click the Export or Print buttons to export or print a summary of the
job parameter settings.
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10 Setting up your Creo
server

Preferences window
Manage your system and resources. The Preferences window is
available from the File menu.

Most of these settings are configured when the system is set up for
the first time. You should consult with the site administrator before
changing any of the server and network settings.

Option Description

Workflow Mode

Note: This tab is only visible with the Trans
Pack.

Enables you to select from the following options:

● IPDS—the system processes and prints files using the
IPDS workflow.

● File Submission Mode—the system processes and
prints files using the File Submission workflow

Note: In IPDS mode, certain features and options in the
workspace are not available.

Server Setup Displays the computer name (host name) of the IC-309m
print controller and the current date and time. The IC-309m
print controller is configured at the factory with a default
generic computer name (host name).

Note: The computer name can be 250 characters long, but
the shared name in your network may be cut to the first 15
characters of, due to the NetBIOS ComputerName
limitation.

Network Setup Displays the available network settings. Clicking Change
enables you to adjust these settings.



Option Description

Remote Tools Setup Provides the following options:

● Enable WebViewer—Enables you to use the Web
Viewer to connect from your computer to the IC-309m
print controller via the network.

● Enable Remote Connection—Enables you to open an
actual workspace for a selected server on your computer
and import jobs, print jobs, preview jobs, and perform
certain workflows. Several users can connect to the
same server simultaneously from different remote
workstations. Clicking Remote Connections Viewer
enables you to view a list of the available remote
connections.

Note: If you change any of the above settings, restart the
IC-309m print controller software for the changes to take
effect.
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Option Description

Security If the Auto log on check box is selected, you can open the
workspace automatically as an operator without logging on
each time.

Notes:

● You can log on as an operator or as a guest if neither
the Auto log on check box nor the Disable guest
connection check box are selected. You must enter a
password.

● The security options don't change how you log on to
Windows.

● The access options you select also apply when you log
on via the Remote Site Manager.

● When connecting from Remote Site Manager to several
servers, the user type (Operator or guest) must be the
same for all connected servers.

Provides the following options:

● Administrator—Enables the user to access all features
and settings on the IC-309m print controller.

● Operator—Enables the user to operate the IC-309m
print controller and configure the general settings in the
Preferences window.

● Guest—Enables you to import your job through an
existing virtual printer, make changes to the job
parameters, and view the workspace. As a guest, you
are not allowed to modify settings in the Preferences
window, modify jobs that don't belong to you, or modify
settings in virtual printers that you didn't create.

● Disable guest connection—Prevents guest users from
accessing the IC-309m print controller.

Disk wipe—By permanently removing data left by files that
you have deleted, the Disk Wipe utility enables you to work
in a more secure environment. The utility eliminates the
contents of your deleted files by scanning all of the empty
sectors on both the system and image disks, and replacing
them with zeros. Non-empty sectors are left untouched. The
Disk Wipe utility automatically starts every time you quit the
IC-309m print controller software.

Note: Make sure that Symantec Norton Utilities software is
not installed on the system, because the Disk Wipe utility
does not function properly with this software.

Image Disks Enables you to adjust the system disk threshold in order to
set the minimum free disk space required to process files.
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Option Description

Configuration Backup Enables you to back up your system configuration to a local
hard drive or network drive, and then restore the
configuration later.

IPDS Settings

Note: This tab is only visible with the Trans
Pack.

Enable end of Job timeout—If the IPDS host does not
send a Define Group Boundary, this option sets the time out
to close the job on the IC-309m print controller. If the job is
not closed the last pages are not printed and the job never
ends.

SMS and Mail Accounts Enables you to configure your mail SMTP server account,
SMS SMTP server account, and add users that will receive
email and text message notifications about the press'
status.

Localization Displays local settings on your system, including the region,
units of measure, and user interface language. You can
change each of these settings by selecting an option from
the menus.

Note: After selecting the language of your choice, the For
these changes to take effect, you must
exit the Creo Server application, and then
restart the computer message appears. You need
to exit the Creo Server application and then restart your
computer.

Deletion policy Provides the following options:

Deletion policy

● Automatically delete jobs from storage—Enables you
to select how often, in days or hours, you want jobs to be
deleted from the Storage area. The default setting holds
the jobs in the Storage area until you manually delete
them

Held Jobs

● Delete held jobs after—Enables you to select how
often, in hours, you want held jobs to be deleted.

Delete global elements

● Delete elements after all related jobs are deleted—
Deletes elements that are not referenced by any job.
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Option Description

Print Queues Manager Provides the following options:

Job batching policy:

● Enable job batching—Prints jobs that have similar
attributes one after another, without pausing between
jobs.

● Disable job batching—Enables the printer to pause
between jobs that have similar attributes.

Held jobs policy

● Bypass held jobs—Bypasses held jobs in the Print
queue

Note: This option moves the next job to the top of the
print queue and saved valuable production time.

● Don't bypass held jobs—Stops the job from printing
from the Print queue.

Note: This option preserves the original order of the files
in the queue.

Job order

● Keep original job order—Processes jobs in the
process queue, one after another, in the order in which
they were submitted to the queue. As soon as the first
job finishes processing, it moves to the print queue.

Note: This option is only available with the Fast pack.

Messages Accounting log setup—Enables you to set the number of
days after which you can overwrite messages. The default
setting is 90 days.

JDF Outputs Creates JDF output for JDF jobs that do not have a
specified target path. If a JDF job has a specified target
path, JDF output is always created.

The IC-309m print controller receives the JDF job ticket via
hot folders, returns JDF output with job accounting
information, and submits JMF (Job Messaging Format)
signals with the job's status.

Note: If you type the file's URL in the HTTP URL box, the
system will submit JMF signals with the job status whenever
the job status of every job in the system changes.
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Option Description

General Defaults Provides the following options:

● Default Image Size —Enables you to select the default
page size to be used when the system is unable to
determine the page size of the imported job.

● Default archive path—Enables you to set the default
path that is displayed when you archive jobs.

● Job Title Recognition (Use when Printing via LPR):

○ Use PostScript internal name: Uses the internal file
name that the print driver found in the PostScript file.

○ Use files name: Uses the job’s given file name.
Selecting this option ensures that the job appears in
the queue with the name last given by the user.

● Default resolution for images without resolution—
Enables you to set the resolution of images that do not
have a resolution.

● SPD Keys— Determines the way SPD key media type is
handled by default (when a rule is not defined). You can
select from the following options:

○ Map Media Type to Paper Profile

○ Map Media Type to Media Type

UI Customization Enables you to select a font size for the IC-309m print
controller user interface that accommodates the resolution
of your monitor.

Provides the following options:

● Small

● Medium

● Large

Setting up e-mail and text message accounts
Set up accounts to receive predefined e-mail and text message
notifications about the status of the press.

Requirements:

To be able to receive text messages, contact an SMS provider that
offers services for SMS transit and register for an SMS account.
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1. From the File menu, select Preferences.

2. Click SMS and Mail accounts.

3. In the Mail SMTP Server box, type the IP address of your
site's SMTP mail server. For more information, consult your
site administrator.

4. (Optional) If you have an SMS account, in the SMS SMTP
Server box, type the SMTP server address of your SMS
provider.

5. To add a user, perform the following actions:

a. Under Users, click +.

b. In the User name box, type the name of the user.

c. Click OK.

d. In the Mail Address box, type the user's e-mail address.

e. In the Mobile Phone Address box, type the user's mobile
phone address—for example,
phone.username@supplier_address.com.

6. In the list of messages, perform one of the following actions:

○ To send all notifications, select the All messages check
box.

○ To send specific notifications, select each message that
you want to send.

7. In the list of users, perform one of the following actions:

○ To send notifications to all users, select the All users
check box.

○ To send notifications to specific users, select the name of
each user who should receive notifications.

8. Click Save.

Note: If you want to deactivate the services for a short period of time—
for example, to perform maintenance procedures—clear the Enable
Services check box in the Preferences window. All of your settings will
be saved.

Setting up a virtual printer

Virtual printers
The IC-309m print controller provides several default virtual
printers (network printers).
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Virtual printers are used for automating workflows, which then
define job streaming. A virtual printer contains preset workflows
that are automatically applied to all print jobs processed with that
virtual printer. Because there is no need to reset job settings for
each job, printing is more efficient.

The default virtual printers are:

● Print
Files sent to this printer are automatically processed and
immediately sent for printing.

● Process
Files sent to this printer are automatically processed and stored
in ready-to-print format in the Storage area. Later, you can
submit the job to print, or change the parameters of the job and
resubmit it for processing or printing.

● Store
Files sent to this printer are spooled to the Storage area and
wait until you submit them for processing and printing. The files
remain in PDL format (such as: PS, PDF, VPS, and PPML).

● Print&Delete
Files sent to this virtual printer are automatically processed,
printed and then deleted.

In addition to using the default virtual printers, you can create a
virtual printer, and edit a virtual printer's settings.

Adding and editing a virtual printer
Add a new virtual printer and then edit job parameters of the virtual
printer.

When you add a new virtual printer, you can specify if it is
published on the network and if the virtual printer parameters
override the PPD parameters.

1. From the Tools menu, select Resource Center.
2. In the Resource list, make sure that Virtual Printers is

selected.

3. Click New.

4. In the Name box, type a name for the new printer that you
want to add.

5. From the Based on list, select an existing printer with similar
settings.

6. The Publish on the network check box is selected by default.
Clear the check box if you do not want to publish the printer on
the network.
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7. (Optional) Select the Override PPD parameters check box if
you would like the virtual printer settings to override the
parameters set in the PPD file.

8. (Optional) In the Comments box, type any comment
regarding the virtual printer parameters.

9. Click Edit to change the job parameters of your new virtual
printer.

Note: If you don't edit the job parameters, the settings of the new virtual
printer are taken from the printer on which it was based.

10. Click Save to save your changes in the job parameters
window.

11. Click OK.

The new printer appears in the virtual printer list.

Restoring the settings for a default virtual printer
Restore a default virtual printer's parameters to the factory
settings.

1. From the Tools menu, select Resource Center.

2. In the Resource list, make sure that Virtual Printers is
selected.

3. Select the default virtual printer whose settings you want to
restore.

4. Click Restore Defaults.

5. When the Restore Virtual Printer message appears, click Yes.
The factory settings for the virtual printer are restored.

6. Click Close.

Removing a virtual printer
The four default virtual printers cannot be deleted.

1. From the Tools menu, select Resource Center.

2. In the Resource list, make sure that Virtual Printers is
selected.

3. From the virtual printer list, select the virtual printer that you
want to delete, and then click Remove(-).

4. Click Yes.
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Best practices for maximizing performance
Maximize performance for all file types.

Performance will be improved for files whose job parameters
include the following settings:
● Delete printed jobs from storage check box and Delete

failed jobs from storage check box are selected.
● Gallop is selected.
● Print order is 1-N.
● Cut and stack imposition method is not active.

Using mark sets

Mark sets
A mark set enables you to place a set of predefined marks, which
are used for finishing purposes, on the printed sheet.

The type of marks and the position of these marks determine how
an inline or offline finisher finishes your job—for example, where
the finisher cuts, staples, punches, and folds the printed sheet.
When you create a mark set, you need to define attributes for
each of the selected mark types. You can define the position,
height, width, and so on, for a mark.

The IC-309m print controller provides three types of marks:
● Registration marks—These marks are an image of a

registration cross hair target that is printed in CMYK
● Finishing marks—Square or rectangular marks that are used by

finishing devices
● Barcodes—Printed using black separation, customized barcode

marks—for example, for page numbers— are used by various
finishing devices
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Once you save a mark set, you can apply it to your job via the job
parameters window.

Creating a custom mark set
Create a custom mark set for your job.

The IC-309m print controller includes a set of predefined marks.
These marks can not be edited or deleted.

1. In the Resource Center window, from the Resource list, select
Mark Sets.

2. To create a new mark set, click Add Mark Set .
A new mark set is created and assigned the name Mark Set
(by default).

3. Type a name for the mark set, and then press Enter.

4. Click Add Mark Type (+). to view the types of marks that you
can add to the mark set.

5. Add the marks that you want to be printed and edit the options
accordingly. You can later go back and change the settings if
required.

The new mark set is added to the list of mark sets. You can apply
these mark settings in the job parameters window by selecting
Finishing > Special Marks.

Note: When you enable the Align Back to Front option, the mark on the
back side overlaps the mark on the front side.
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Adding a barcode
Add a barcode to a mark set, and define the barcode data code in
the Resource Center window.

The IC-309m print controller provides four predefined types of
barcodes:

● Code 39—An alphanumeric barcode of up to 50 characters.

● EAN-8—A numeric barcode of up to eight numbers. Seven
numbers are custom numbers that you select and one number
is determined by the barcode engine.

● Interleaved 2 of 5—A numeric barcode of up to 50 numbers.

● DataMatrix—An alphanumeric barcode of up to 2,000
characters.

1. From the Tools menu, select Resource Center.

2. In the Resource list, make sure that Mark Sets is selected.

3. Select a mark set, and then either click Add Mark Type or
click to select an existing mark.

4. In the Mark Type list, select Barcode Mark.

5. In the Height area, type the height of the barcode that you
want to add.
You cannot change the barcode's width.

6. In the Barcode Type list, select the barcode that you want to
add.

7. Click Edit Variables.
The Edit Barcode Variable window appears.
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8. In the Enter a barcode value area, type the barcode value
according to the requirements of the type of barcode that you
selected.

9. Define variable information for a barcode—for example, the
total number of booklets or the sheet number—by performing
the following actions:

a. Type the number sign # where you want to define a
variable.

b. In the table, select the barcode number, and select the
variable information that you want the barcode to include.

c. (Optional) For variable information consisting of two or
more digits, merge two or more adjacent barcode numbers
by selecting the rows and clicking Join.

d. Click Save.
The barcode appears in the Code box Resource Center
window.

10. Select the sheet on which you want the barcode to appear
(the Front check box or the Back check box), or select both
check boxes if you want the barcode to appear on both sides.

11. Type the x-coordinate and y-coordinate that indicate the
position of the barcode on the sheet.
0,0 indicates the beginning of the sheet.
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12. Select a reference point for the x-coordinate and y-coordinate
that you defined for the barcode position.

13. (Optional)To rotate the barcode on the sheet, select a value.

Next: You can assign a mark set to your job in the job parameters
window by selecting Finishing > Marks and barcodes.

Maintaining your settings

Backing up the configuration
You can back up your configuration to a local hard disk, or DVD.

Note: It is recommended that you back up your configuration to external
media before reinstalling the operating system and software.

1. From the File menu, select Preferences.
The Preferences window appears.

2. In the Preferences window, under Administrator, select
Configuration Backup.

3. In the Configuration backup area, click Browse.
The Save dialog box appears.

4. Locate the folder you want to back up.

5. Enter the file name.

Note: It is recommended that you use the current date as part of the file
name.

6. Click Save.

7. In the Configuration backup area, click Start Backup.
After a few moments, the backup complete message appears.

Note: The last path is saved and displayed to the path box. If the
backup was made to external media, the displayed path will be the
default: c:\ic-309m\General\Configuration.

8. Click OK.

9. Click Save to close the Preferences window.

Restoring the configuration
Requirements:

Make sure that you have previously backed up your configuration.

The configuration file extension is .cnf.
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Note: Restore can only be implemented for the same software version.

1. From the File menu, select Preferences.
The Preferences window appears.

2. In the Preferences window, under Administrator, select
Configuration Backup.

3. In the Restore configuration area, click Browse.
The Open dialog box appears.

4. Locate the folder in which you backed up the configuration.

5. Select the file, and then click Open.

6. Click Start Restore.

7. Select the categories that you want to restore, and click OK.

All custom tables and sets—for example, new virtual printers— are
added to the system when you restore the configuration.

Tools for maintaining your system
The IC-309m print controller includes a number of tools to help
you maintain your system. The available tools include:

● Formatting the Image Disk: Formats the image disks and
performs system recovery.

● Disk wipe: Enables you to work in a more secure environment,
by permanently removing data left by files that you have
deleted.

● Auto update tool: Enables you to install software updates.
These updates include the latest service packs, Windows hot
fixes, and related patches for your IC-309m print controller.

Tools for maintaining your system 153



154 Chapter 10—Setting up your Creo server



11Working with Creo
server tools

Remote Site Manager overview
The Remote Site Manager enables a site manager to monitor the
status of the IC-309m print controller and other Creo servers
connected to printers on a network. It also enables you, the site
manager, to operate these servers from a remote computer.

The Remote Site Manager software includes the following tools:

● The Remote Workspace tool—Allows users to open an actual
workspace for a selected server on their computer and import
jobs, print jobs, preview jobs, and perform certain workflows.
Several users can connect to the same server simultaneously
from different remote computers.

● The EZ Connect tool—Allows users to view updated printer
status information.

Note: You can run the Remote Site Manager on your desktop while you use
other applications on your computer. The Remote Site Manager does not
disrupt server activity.

Activating the remote tools
Set up a network connection between a Windows computer and
the IC-309m print controller.

You need to select the Enable the Remote Connection
parameter in the Preferences window to connect remotely to the
IC-309m print controller.

1. On the IC-309m print controller, from the File menu, select
Preferences.
The Preferences window appears.

2. Under Administrator, select Remote Tools Setup.

3. In the WebViewer setup area, select Enable Webviewer.
4. In the Remote workspace setup, select Enable Remote

Connection.

Tip: In this area, you can view Connection Status and how many clients
are connected.

5. Click Remote Connections Viewer to see the list of
connections.



6. Click Save.

Installing the Remote Site Manager in Windows
Install the Remote Site Manager so that you can add servers,
monitor their status, and obtain information about the printer, all
from your computer.

1. On your desktop, click Start > Run.

2. In the Run dialog box, type the exact name of the server
where the Remote Site Manager is located, as follows
 \\<server_name>.

3. Click OK.

4. In the \Utilities\PC Utilities folder on the IC-309m print
controller, locate the Remote_Site_Manager.exe file.

5. On your computer, double-click the
Remote_Site_Manager.exe file.

6. During the installation process, if a Windows Security
message appears about installing X-Rite device software, click
Install.
The Remote Site Manager is installed on your computer. The
Remote Site Manager icon  appears on your taskbar after
the application is started.

7. Click OK.

The Remote Site Manager appears under Start > Programs >
Creo Server > Remote Site Manager.

Installing the Remote Site Manager in Mac OS X 10.6 (64 bit)
and later

Install the Remote Site Manager so that you can add servers,
monitor their status, and obtain information about the printer, all
from your computer.

1. From your computer, navigate to the \\<server name>
\Utilities\Mac Utilities folder on the Creo server.

2. Double-click the Remote_Site_Manager.dmg file.
The Remote Site Manager is installed on your computer. The
Remote Site Manager icon  appears on your taskbar after
the application is started.

3. Click Close.

A shortcut to the Remote Site Manager appears in the path
Applications\Creo_Server_Tools\Remote_Site_Manager.
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Adding Creo servers to the Remote Site Manager
Using the Remote Site Manager software, set up servers via the
Remote Site Manager Setup window. You can add up to 15 Creo
servers.

1. On the taskbar, right-click the Remote Site Manager icon.

2. From the menu that appears, select Setup.
A message notifies you that you need to add a server before
using the EZ Connect tool.

3. Click OK.
The Remote Site Manager Setup window appears.

4. In the Remote Site Manager Setup window, click Add.

5. In the Hostname/IP box, type the exact name of the server
that you want to add—for example, Server1.

6. In the Display Name box, type a name of your choice for the
server.

7. Click Add.
Your new server appears in the Remote Site Manager Setup
window.

8. Click Save.
Your new server's name is added to the menu that appears
when you right-click the Remote Site Manager icon.

9. To add another server, repeat steps 4-8.

Using the EZ Connect tool to view the printer status
Requirements: Before you can use the EZ Connect tool, you
must add a server.

1. On the taskbar, right-click the Remote Site Manager icon.

2. In the menu that appears, select EZ Connect.
The EZ Connect window appears.

3. Check the status of the printer that is connected to the
selected server.

Removing the Remote Site Manager in Windows
Requirements:
Note: You must exit both the Remote Site Manager and the Remote
Workspace applications before you uninstall the Remote Site Manager.
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On your desktop, click Start > Programs > Creo Server >
Remote Site Manager > Uninstall V1_0.

Removing the Remote Site Manager in Mac OS X
Requirements:
Note: You must exit both the Remote Site Manager and the Remote
Workspace applications before you uninstall the Remote Site Manager.

To remove the Remote Site Manager and the remote
Workspace applications, delete the following folders:

● <installation_disk>\Applications
\Creo_Server_Tools\Remote_Site_Manager

● <installation_disk>\Library\Application Support
\Creo_Server_Client_Tools\Remote_Site_Manager

● <installation_disk>\Library\Application Support
\Creo_Server_Client_Tools\Remote_Workspace

Remote Workspace overview
The Remote Workspace tool opens an actual workspace for the
selected server and enables you to import jobs, print jobs, and
perform the following workflows:

● View and manage jobs
● View printer information
● Set job parameters

Notes:

● The Remote Site Manager enables you to view and control multiple
workspaces of available servers on the network.

● On a Mac computer, Eclipse help is not available when you access a
IC-309m print controller via the remote workspace.

● When changing settings in the Preferences window from the Remote
Workspace application, the settings apply to the IC-309m print controller,
and not to the client session of Remote Workspace.

See also:
Connecting to the Remote Workspace on page 158

Connecting to the Remote Workspace
Requirements: Make sure that you have activated the remote
connection option on the IC-309m print controller.
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1. On the taskbar, right-click the Remote Site Manager icon.

2. In the menu that appears, select one of the servers.
The Remote Workspace window of that server appears.

Overview of the Web Center
The Web Center is a web page that provides online information
and can be accessed from a Windows or Mac computer. You can
connect to the Web Center with the Internet Explorer 5.0 (or later)
and Apple Safari browsers.

The Web center enables you to:

● Download remote client tools and printer drivers

● View related documentation

● Find links to related vendors or products

● Connect to the printer's web user interface in the Remote UI
link.

Connecting to the Web Center

Note: To connect to the Web Center from a client workstation, you must first
enable the remote connection in the preferences of the IC-309m print
controller.

1. Open any web browser, for example, Internet Explorer.

2. In the address field type: http://<server name>—for example, if
the IC-309m print controller station name is server_1, type
http://server_1.
The IC-309m print controller Web Center appears.

Office Hot Folder tool
The Office Hot Folder tool enables you to automate the printing of
Microsoft Office files when you work remotely. You can drag
Microsoft Office files to a hot folder and then submit the files for
printing on the Creo server.

The following Microsoft Office versions are supported:

● Microsoft Office XP

● Microsoft Office 2003

● Microsoft Office 2007

● Microsoft Office 2010
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Installing the Office Hot Folder tool
Requirements:

Microsoft Office must be installed on your computer in order to
work with Office Hot Folder tool.

1. On the IC-309m print controller, locate the D:\Utilities\PC
Utilities folder.

2. Double-click the Office_HF.exe file.
The Office Hot Folder tool is installed on your computer, the
Office HF icon appears on your taskbar, and the Office Hot
Folder tool appears. All network printers that are currently on
your computer appear in the window.

3. Right-click this icon to perform the following actions:

○ Open: Open the Office Hot Folders tool and create and
manage hot folders

○ Start: Activate file processing in the tool

○ Stop: Deactivate file processing in the tool

○ Refresh: Restart the tool

○ Exit: Shut down the tool

Creating an Office hot folder
Requirements:

The Office Hot Folder tool must be open.

1. In the Office Hot Folder tool, in the Printers pane, select the
virtual printer for which you want to create a hot folder.

2. Click Create HF.

You can now print Microsoft Office files through this hot folder.

Using the Office Hot Folder tool to print
Requirements: One of the Microsoft Office 2003, 2007, or 2010
file formats must already be submitted to one of the hot folders set
up in the Office Hot Folder tool:
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1. In the Creo Office hot folders window, select the hot folder that
you want to use to submit your file.

2. Drag the file to the hot folder.

Your file is automatically processed and printed according to the
hot folder workflow.

Remote Job Ticket software
Remote Job Ticket overview

The Remote Job Ticket software enables you to create a Job
Definition Format (JDF) file. This JDF file contains a set of printing
parameters (job ticket) and may also include the path to a file to be
printed using those parameters.

Note: If you assign a file to a job ticket, make sure that the file location can
be accessed by the Creo server.

This software can be installed and used on Windows or Mac OS X
computers.

Because you work on a remote computer, you don't need to be
connected to a Creo server to create a job ticket. You can assign a
job ticket to any of the supported file types.

With the Remote Job Ticket software you can:

● Create a job ticket

● Open a job ticket

● Load job parameters from a selected server

● Send a job to print using a job ticket that you created
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Note: Custom imposition templates, including the pre-defined Folded
Signature imposition templates, cannot be previewed from the Remote Job
Ticket software.

Language settings
The Remote Job Ticket software displays the language of your
computer's Windows operating system. To ensure that the
language that the Remote Job Ticket software displays and the
language of the job parameters window that you work with are the
same, set the language of your computer's operating system to
the same language as the Creo server that you are creating the
job ticket for.

Installing the Remote Job Ticket software in Windows
1. From your computer, navigate to the \\<server name>

\Utilities\PC Utilities folder on the Creo server.

2. Double-click the Remote_Job_Ticket.exe file.

The Remote Job Ticket software opens. A shortcut to the Remote
Job Ticket software appears under Start > Programs > Creo
Server > Remote Job Ticket > Remote Job Ticket V1_0.

Installing the Remote Job Ticket software in Mac OS X
1. From your computer, navigate to the \\<server name>

\Utilities\Mac Utilities folder on the Creo server.

2. Double-click the Remote_Job_Ticket.dmg file.

3. Double-click the Remote Job Ticket package to install the
software on your computer.

The Remote Job Ticket software is installed on your computer.
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Creating and managing job tickets

Creating a job ticket in Windows

1. From the Start menu, select Programs > Creo Server >
Remote Job Ticket > Remote Job Ticket V1_0.
The Remote JT window opens.

2. To add a server, perform the following actions:

a. From the Tools menu, select Use JT Settings From >
Setup.

b. In the Setup window, click Add.

c. In the Server Name box, type the name of the server that
you want to add.

d. In the IP/Host Name box, type the IP address or the host
name of the server.

e. Click Add.
The job ticket settings for the server are loaded.

f. In the Setup window, click OK.

3. From the Tools menu, select Use JT Settings From and in
the list that appears, click the server that you just added.
The following message appears if unsaved changes were
made to the current open job ticket:
Are you sure you want to change the displayed 
server without changing the template?

4. Click Yes.

5. Set the required job parameters.

6. Click Save As.

7. In the Save JDF dialog box, type a name for the job ticket,
and click Save.

The job ticket is saved in the path defined in the Preferences
window. The default path for Windows 7 is C:\ProgramData
\Creo_Server_Client_Tools\Creo_Server_JT
\V1_0\Creo_Server_JT\Creo_Server_JT_IC-309m_1\servers
\FactoryDevice\JT files\IC-309m.

See also:
Adding a server on page 167
Removing a server on page 167
Renaming a server on page 167
Defining a new location for saved job tickets on page 167
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Creating a job ticket in Mac OS X

1. From the Applications folder, navigate to /Creo_Tools/
Remote_Job_Ticket/ and double click the
Remote_Job_Ticket icon.
The Remote JT window opens.

2. To add a server, perform the following actions:

a. From the Tools menu, select Use JT Settings From >
Setup.

b. In the Setup window, click Add.

c. In the Server Name box, type the name of the server that
you want to add.

d. In the IP/Host Name box, type the IP address or the host
name of the server.

e. Click Add.
The job ticket settings for the server are loaded.

f. In the Setup window, click OK.

3. From the Tools menu, select Use JT Settings From and in
the list that appears, click the server that you just added.
The following message appears if unsaved changes were
made to the current open job ticket:
Are you sure you want to change the displayed 
server without changing the template?

4. Click Yes.

5. Set the required job parameters.

6. Click Save As.

7. In the Save JDF dialog box, type a name for the job ticket,
and click Save.

The job ticket is saved in the path defined in the Preferences
window.

Loading job parameters from a selected server
Requirements: The server from which you want to load job
parameters must be in the Remote Job Ticket list of servers.
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1. From the Tools menu, select Use JT Settings From.

2. In the list that appears, click the server from which you want to
load job parameters.

A check mark appears next to the selected server, and the
Remote Job Ticket software loads the appropriate job parameters
window.

Submitting a file with job ticket for printing
Requirements: You can only submit a file for printing with a job
ticket that contains the required job parameters.

1. In the Remote Job Ticket software main window, click Submit.

2. In the Name box, type the name of the job ticket.

3. Click Browse.

4. In the Browse dialog box, locate the file that you want to print
using the job ticket, and click Open.

5. Click Submit.

The file is sent to the Creo server and is printed according to the
settings defined in the job ticket.

Submitting files from Prinergy Workshop via Digital
Submit to the Creo server
Requirements: Make sure you have added a Creo server to the 
Kodak Prinergy.

1. In Job Finder, select the Jobs view to view the list of
available jobs.

2. Double-click the job that you want to send to the Creo server.
The Job Manager window appears.

3. In the Job Manager window, right-click the file located in the
Input Files or Pages area, and then select Send to Digital
Direct.
The Process Info window appears and then the Submit to
Digital Print window opens.

4. Set the Order Quantity.

5. Select the Press Settings tab.

6. Select the digital press that you want to print the file to.

7. Click Choose and select the JDF template that contains the
settings for your job.

8. Click Edit, to adjust these settings.
The Remote JTwindow appears.
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9. Click Save, and then close the Remote JT window.

Note: When you edit and save Creo server job parameters settings from
within Prinergy, the settings are applied only to your current job and not
saved for future jobs.

10. From the Submit to Digital Print window, click Submit to send
the file to be processed and printed.

Note: Select Submit to Press Immediately, to send the file as soon as
you click Submit. Otherwise, the file will be sent at the scheduled time.

Printing from the Prinergy software
Requirements: The Prinergy software must be running.

1. In the Prinergy Job Manager window, in the Pages area,
select the job that you want to print, and drag it to the Loose
Page Proof template.

2. In the Start Process dialog box, select Edit Process
Template.

3. In the Loose Page Proof template dialog box, click the Include
JDF for Digital Print tab.

4. In the Device Selection list, select Creo Server.

5. In the PDF Path box, type \\<Creo server name>\<any
shared folder on the Creo server>.

Note: It is recommended that you use the JobUploads shared folder.

6. In the JDF Path box, type \\<Creo server name>\<any hot
folder on the Creo server>.

7. In the Select JDF Templates area, click Browse.

8. In the File Browser dialog box, select the required JDF file,
and click the Select <JDF_file_name> button.

9. Click OK.

10. In the Start Process dialog box, click OK.

The job is printed with the settings defined in the JDF file.
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Adding a server

1. From the Tools menu, select Use JT Settings From .

2. Click the Add button.

3. In the Server Name box, type a name for the server that you
want to use.

4. In the IP / Host Name box, type the IP address or host name
of the server that you want to use.

5. Click Add.

6. Click OK.

The new server appears in the list.

Removing a server
Requirements: The Remove button is available only if the list of
servers contains more than one server.

1. From the Tools menu, select Use JT Settings From .

2. Under Server Name, select the server that you want to
remove.

3. Click the Remove button.

4. In the confirmation message window, click Yes.

5. Click OK.

The selected server is removed from the list.

Renaming a server

1. From the Tools menu, select Use JT Settings From > Setup.

2. Under Server Name, double-click the server that you want to
rename.

3. Type a new name for the server, and press Enter.

Note: The name of a server must be unique.

4. If a server with the same name already exists, you are
prompted with a message. To replace the existing server, click
Yes.

5. To close the Setup dialog box, click OK.

Defining a new location for saved job tickets

1. From the Tools menu, select Preferences.
The Preferences dialog box appears displaying the default
location of the saved job tickets.
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Note: If you have already changed the location, the Default JDF
Location box displays the location that you selected previously.

2. In the Default JDF Location box, click Browse and select the
desired location.

3. Click OK.

4. In the Preferences dialog box, click OK.

Job tickets that you create from now on are saved in the new
location.

Updates

The update feature
You use the Check for Updates feature to check if a new version
of the Remote Job Ticket software is available, or if the job
parameters settings of the server selected on the Remote Job
Ticket changed.

The following types of resources are examples of information that
may be updated:

● Paper names

● Gradation tables

● Imposition templates

Checking for updates

1. From the Help menu, click Check for Updates.
The Remote Job Ticket software must be connected to a
server when checking for updates.

2. One of the following occurs:

○ If a newer version of the Remote Job Ticket software is
available, or a new set of parameters is available for the
currently loaded server, an update process begins. At the
end of the process, click Close.

○ If a new version of the software is not available, and there
are no new parameters to be loaded, then in the Update
message, click Close.

A new version of the Remote Job Ticket software, and/or a new
set of job parameters available on the loaded server, is installed
on your computer.
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Removing the Remote Job Ticket from Windows
On your desktop, click Start > Programs > Creo Server >
Remote Job Ticket > Uninstall Remote Job Ticket V1_0.

Removing the Remote Job Ticket from Mac OS X
Requirements:
Note: You must exit the Remote Job Ticket software before you can uninstall
it.

Delete the following folders:
a. /Applications/Creo_Server_Tools/

Remote_Job_Ticket
b. Library/Application Support/

Creo_Server_Client_tools/Creo_Server_JT

Changing the Network settings to TCP/IPv6 on a remote
computer

This procedure describes how to change the Network settings
from TCP/IPv4 to TCP/IPv6 on a remote computer.
1. On the remote computer, from the Control Panel, uninstall

the Remote Job Ticket application.
2. From the remote computer, navigate to the \\<server name>

\Utilities\PC Utilities folder on the Creo server.
3. Double-click the Remote_Job_Ticket.exe file.

The Remote Job Ticket software opens. A shortcut to the
Remote Job Ticket software appears under Start > Programs
> Creo Server > Remote Job Ticket > Remote Job Ticket
V1_0.

4. From the \\<server name>\Utilities\PC Utilities folder
on the Creo server, double click the
Set_IpV4_IpV6_Protocol.bat file
The following dialog box appears:
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5. Type 1.

6. On the remote computer, change the Network settings to
support TCP/IPv6.

7. Reboot the remote computer.

8. Reconnect the Remote Job Ticket application and continue
the set up as usual.
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12 Troubleshooting

Job History window
The Job History window lists all of the messages generated during
the workflow of the selected job. You can view the job title and
owner (the user name of the system from which the job originated)
near the top of the window.

Job Information

Job title The job's file name.

Sender The user that sent the file to print.

Show Click one of the icon types (Information,
Warning, or Error) to view or not view (toggle)
those message types in the Job History
window.

Type There are three types of messages:

●  Information

●  Warning

●  Error

Date & Time The date and time on which the message was
emitted (the time stamp).

Stage The stage in the workflow—for example,
System or Process.

Message The message text.



Handling alerts and jobs
If your job has failed or is frozen, you can view an alert message
about the failed or frozen job.

1. In the workspace, do one of the following:

○ In the Print Queue, click the frozen icon  that appears
next to the frozen job.

○ In the Storage area click the failed icon  that appears
next to the frozen job.

○ Select the job with the failed or frozen icon and then click
the Alert button  on the toolbar.

If you click the frozen or failed icon, a message appears
detailing the problem.

If you click the Alert button  on the toolbar, the Alerts
window appears.

2. Close the alerts information.

3. If a job was frozen, follow the directions in the alert message
to correct the situation (incorrect or missing paper stock or
finisher).
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Aborting a job
Requirements: A job that is processing or printing.

Right-click the running job in one of the queues, and select
Abort and then click Yes.
The job moves from the queue to the Storage area. The
Aborted status is assigned to the job, and the next job in the
queue starts running.

Resume printing
Resume printing an aborted job.

Right-click the aborted job in the Storage area, and select
Resume printing.
The job continues printing from the last page that was printed.

Alerts window
In the Alerts window you can view system alerts, and alerts for the
selected job.

Alert window options

Show Selected Displays the alert for the selected job in the
queues or Storage area.

Show All Displays the system alerts and the alerts for
all jobs.

Clear All Clears all of the alerts from the window.
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Printing system messages
Print a list of system messages from the Message Viewer window.

1. From the Info menu, select Messages Viewer.

2. Filter and sort the message list as desired.

○ Click any message type icon—for example, Error —To
filter out such messages.

○ Click a column header to sort the list by that column.

3. Click Print List.
The Print window is displayed.

4. Set the printing options as desired, and click OK.

The data is printed according to the current filtering and sorting.
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13Glossary

absolute colorimetric
A method of color matching during the translation of files from one
device to another. The absolute colorimetric method refers to the
use of device-independent color space.

amplitude-modulated (AM) screening
A type of halftone screening in which the size of the dots varies but
the spacing between dot centers is constant. For darker areas, the
dots are bigger, and for lighter areas, they are smaller.

Automatic Picture Replacement (APR)
Technology in which two versions of a file are created—a high-
resolution file and a low-resolution file called PSImage. You use
the latter file for positioning and manipulating images in DTP
software. The high-resolution file automatically replaces the low-
resolution version during the RIP process.

bitmap file format
A file format in which graphics are represented by a series of
pixels. The file name extension is .bmp.

booklet
In a variable information (VI) job, a personalized copy of a
document. A booklet can consist of several pages, but the entire
document is targeted at a specific individual or address. VI jobs
contain elements that differ from booklet to booklet, including text,
graphics, pictures, and page backgrounds.



bounding box
In a PostScript file, the smallest rectangle that encloses all of the
graphic elements. The bounding box is specified by two sets of
coordinates.

brightness
The amount of light reflected from a surface, regardless of the hue
or saturation of color. In print reproduction, the reflectance of the
paper affects brightness.

cache
To store data after it has been accessed so that future access will
be faster.

click charge
A fee that vendors charge for each printed or copied page. Click
charges are part of the maintenance agreement between the
vendor and the customer.

CMYK
A color representation scheme (or color space) in which cyan,
magenta, yellow, and black are combined to create full-color
images.

colorant
A pigment, dye, phosphor, or other such substance that produces
a color. Colorants are like building blocks of colors—for example,
green is composed of cyan and yellow, so cyan and yellow can be
considered colorants that make up the color green.

color cast
The predominance of a particular color that affects the whole
image in the original, proof, or reproduction. A color cast is due to
an excess of a color pigment or light. It is most obvious in gray and
near-gray areas.

176 Chapter 13—Glossary



color channel
A single color, such as red, green, or blue.

color correction
The process of improving or altering the color components of an
image to compensate for deficiencies in printing inks, to solve
problems in the color separation itself, or to fulfill a customer’s
request for modification.

color gamut
The range of possible colors that can be represented in a given
circumstance, such as within a given color space or by a certain
output device.

color management
A process that aims to control the representation of colors across
a variety of output devices so that the colors that are generated
appear consistent. Color management is based on the
coordination of three processes: device calibration, device
characterization, and conversion from one color space to another.

color mapping
A color-correction method used to convert an input file’s color
space to a target’s color space.

color profile
A description of the range of colors that a device can produce. A
color profile makes it possible to convert the color space of one
device (such as inkjet printer) to another device (such as a
computer monitor).

color rendering dictionary (CRD)
A three-dimensional lookup table for transforming all process color
models.
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color space array (CSA)
A three-dimensional or four-dimensional lookup table that contains
data for translating a device-dependent color space into a device-
independent L*a*b* color space.

composite mode
A mode of operation in which all the color information associated
with a particular page is described on one page of a PostScript
file. During RIP, the file is separated into process colors and spot
colors, one file for each color. This mode of operation is the fastest
and most efficient in most cases.

contrast
The ratio between the light tones and the dark tones in an image.
If you increase the contrast, highlights become lighter while
shadows become darker.

conventional screening
A method of screening in which an image is broken down into a
series of dots of varying sizes that are placed in a rigid grid
pattern. Color images are separated into the four process colors,
and individual screens of color are created and then skewed at
angles to reproduce the image in print.

creep
The extension of middle pages of a folded signature slightly
beyond outside pages. Shingling compensates for creep.

CT file format
A four-color (CMYK) continuous-tone (or contone) raster file
format. Gradient tones and continuous-tone data are sometimes
converted to CT format.
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database
A software module that holds site configuration information, edition
plan information, and the current state of each process and
planned item. At least one workstation at each site must have a
database installed.

DCS (desktop color separation)
An EPS format containing five files: four of the files contain the
separated color information for each of the CMYK colors and the
fifth is a low-resolution composite file for use in electronic page
layout. DCS1 format has five separate files. One file acts as the
preview and the other four contain the information for printing the
different channels of CMYK color.

DCS-2
A desktop color separation (DCS) file with additional files that
contain spot color information.

densitometer
An electronic instrument which measures the optical density of film
or reflective media. A transmission densitometer is used to
measure films while a reflection densitometer is used to measure
photographs and ink laydown on press sheets.

density
A measurement of the ability of light to be absorbed by an ink and
paper combination. A darker tone has a higher density than a
lighter tone.

density range
The range of density from highlight to shadow on a film negative or
positive or on the printed image. It is calculated as the
mathematical difference between the densities of the darkest and
the lightest tone values.
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device
An individual occurrence of a physical device that reproduces an
image. Devices have a type and a customer-specified name.
Because the declaration of a device does not include its operating
conditions—such as ink selection, type of screening, and paper—
you cannot measure the color response of a device on its own. (In
ICC terminology, the declaration of a device does include its
operating conditions.)

device-independent color space
A color space based on human perception of color, measured
using a colorimeter or spectrophotometer. The color space is
independent of the color capabilities of any specific device. An
example is CIELAB. A device-independent color space may be
used as an intermediate color space when converting from one
color space to another, for example, from CMYK to RGB.

device link profile
A one-way link or connection between two color imaging devices.
Such a one-way link can be between devices such as a scanner
and a printer, a scanner and a color monitor, or two printers. Using
device link profiles helps shorten the conversion path in certain
applications and saves computing time.

device profile
A type of ICC profile that represents the relationship between
colorant tint values of a device and the resulting color. It has two
sets of color mapping tables: one set maps device colorant tint
values to the profile color space while the other set maps the
profile color space to device colorant tint values.

dot area
The percentage of an area covered by halftone dots, ranging from
no dots at 0 percent to a solid ink density at 100 percent. The size
of a single dot is stated in a percentage of the area it occupies.
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dot gain
A printing effect which results in dots being printed larger than they
should be. It occurs as a result of ink spreading on the printed
page, and if not compensated for, can lead to an image appearing
too dark.

element
Any item within a job—including an input file, page, page set,
signature, surface, or separation.

frequency-modulated (FM) screening
A method of creating halftones where the spots are all the same
size, but the frequency or number of dots changes in a given area.
There are more dots in a dark area and fewer in a light area.

frozen job
A job for which the appropriate paper stock is not available: for
example, the correct paper type, size, or weight.

gravure printing
A printing method in which the image is engraved through a
screen below the surface of a cylinder. The ink is transferred to
paper when pressed to the cylinder. Gravure is used for very long
print runs and on many substrates.

gray balance
The values for yellow, magenta, and cyan that produce a neutral
gray with no dominant hue when printed at a normal density.

gray component
The amounts of CMY in a color which result in neutral gray, based
on the lowest separation value of the color.
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gray component replacement (GCR)
A method for reducing the CMY amounts that produce the gray
component in a color, without changing the color hue.

halftone screen
On halftone output, the fine grid that positions the halftone dots.

job flow
The job parameter settings of selected virtual printers, which are
automatically applied to all jobs printed using those virtual printers.
These settings determine how a sent or imported file is processed.
For example, a file sent to a virtual printer with a Process & Print
job flow will be RIPed, printed, and stored in the Storage Folder. A
file sent to a Process & Store job flow virtual printer will be RIPed
and stored, without printing.

job ticket
A hidden file that is created when you associate an input file with a
particular template. The job ticket contains all the instructions for
processing the input file.

L*a*b*
A device-independent color measurement system that measures
Lightness (or Luminance) and two color coordinates, A (red/green)
and B (blue/yellow). It may be used as an intermediate color space
used when converting from one color space to another (for
example, from CMYK to RGB).

long-edge first (LEF)
A printer page orientation where pages are delivered to the printer
with the long edge of the paper going in first.

lookup table (LUT)
A two or three-dimensional array of values that stores information
about specified input-output relationships. When an input value is
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known, the system can automatically determine the correct output
value. For example, the system can find the required dot size for a
given set of printing conditions based on the stored gray level.
Color setups can be saved in color tables (color transformation
tables), which is one of the many kinds of LUTs.

PDF/X
Abbreviation for Portable Document Format eXchange. An
exchange format for sending pages between a page preparation
site and a printing site. PDF/X is a subset of the full PDF
specification.

PPD (PostScript Printer Description)
A file specification set by Adobe Systems, Inc. It contains output-
device-specific information, including fonts, line screens, offset
margins, supported page sizes, and so on.

pre-separated file
A PDF, PostScript, or TIFF file that contains a separate page for
each color in a document. A standard process color job would
have four pages—one for each process color. A job with spot
colors would have a page for each spot color and a page for each
process color.

printer description file
A PPD file or PDF file that Apple Macintosh software uses to
prepare pages and documents for specific output devices.

process
An action initiated on a file—for example, refining a PostScript file,
copying a file from one folder to another, or outputting a TIFF file
to plate.

process colors
The four ink colors that are used to reproduce full-color images:
cyan, magenta, yellow, and black (CMYK). Combinations of CMYK
are used to reproduce many colors of the spectrum.
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PSImage
A low-resolution EPS file that is part of the Automatic Picture
Replacement (APR) workflow. You use PSImage files to position
images in page layout. You can create and edit a PSImage file in
various applications, such as PSImage Exporter in Adobe
Photoshop, Copydot Toolkit, and oXYgen software. If you edit a
PSImage file (for example, you add a mask or a clipping path), the
workflow software applies your changes to the high-resolution file
and automatically replaces the PSImage file during the RIP
process.

relative colorimetric
A method of color matching. When translating colors from one
device to another, it retains the colors that fall within the range of
both devices.

RGB
Abbreviation for the additive primaries—red, green, and blue.
These colors are the predominant colors in the visible light
spectrum that the human eye can detect. The RGB colors are
used, for example, in video monitors, scanners, and other devices
in which the light is direct and not reflected.

rich black
A black area to which layers of other inks, referred to as support
screens or booster colors, have been added to make the color as
dark as possible.

RTP (ready-to-print) job
A job that has been RIPed and is in the appropriate format for
printing. You can submit RTP jobs for reprinting without
reprocessing them.

screen angle
The angle at which a halftone screen is set for printing halftones.
Proper screen angles minimize moiré patterns.
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shadows
The darkest part of an image (original and reproduction). A
shadow has densities near the maximum. In a reproduction,
shadows are printed with dot areas between 80 percent and 100
percent.

sheet
Both surfaces of one printed press sheet.

short-edge first (SEF)
A printer page orientation where pages are delivered to the printer
with the narrow edge of the paper going in first.

slug
The text added to one side of the printed layout. The slug contains
information about the job and its settings. Also referred to as label
or caption.

SMB (Server Message Block)
SMB, also known as CIFS (Common Internet File System), is a
protocol for sharing files, printers, and other resources between
computers.

smooth scaling
The ability to maintain the same detail and smoothness with
different degrees of enlargement. Smooth scaling allows you to
scale up low-resolution images without creating a jagged
appearance.

source profile
The specifications for how the CMYK and RGB values in a file
should be interpreted as an actual color when displayed or output
through a given device.
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spine trim size
The space between adjacent pages on a printed sheet.

spot color
A special ink color, not included in the process color set, that is
used to specify the color of a graphic design element.

spot color library
A collection of spot colors for which spotless color recipes are
sought. A spot color library contains one or more spot colors. Each
spot color includes a name and a CIELAB color space.

step and repeat
The procedure of copying the same image by stepping it in
position both horizontally and vertically according to a
predetermined layout.

stochastic screening
A digital screening process that converts images into very small
dots of equal size and variable spacing. Also referred to as
frequency-modulated (FM) screening.

substrate
Any printing surface to which ink will adhere. Also referred to as
stock.

TIFF
Acronym for Tagged Image File Format. TIFF is a file format used
to describe, store, and exchange bitmap images. TIFF is cross-
platform, highly flexible, and capable of saving a wide variety of
image types, including photographs and illustrations. Most page
makeup and image editing software supports TIFF.
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TIFF/IT-P1
Acronym for Tagged Image File Format for Image Technology,
Profile 1. A file format that is similar to TIFF/IT, but provides a
minimized set of options that allows simpler implementation when
the full set of TIFF/IT options is not required.

tint
The percentage value assigned to a dot.

trapping
A printing technique in which adjacent printed colors are slightly
overlapped to ensure that white space does not appear between
the colors.

variable print specification
Formal language designed for effective production of variable
information documents.

vector drawing
The geometric system used to define lines and curves in computer
graphics. It is most often used for line drawings.

virtual printer
A printer that contains preset workflows that are automatically
applied to all print jobs processed with that virtual printer.
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